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Introduction 

Welcome to PersonalBrain™, the first software package that lets you use your 
computer the way you use your mind—intuitively. PersonalBrain’s easy-to-use 
visual interface integrates information from the Internet and all your applications, 
allowing you the freedom to think less about your computer and more about your 
work and interests. Your mind works in a way that is unique to you; PersonalBrain 
allows you to organize your information in the same way, without limiting you to a 
pre-determined file structure. 

PersonalBrain uses a brand new data format called Thoughts, to mirror the way 
you use your mind. The human mind is a container for a virtually limitless number 
of Thoughts. The wonder of the mind, and the source of human creativity, is the 
connectedness of all these Thoughts. Intelligence comes from the mind’s ability 
to think associatively—that is, to leap from Thought to Thought, building webs of 
greater and greater complexity, until new ideas are built. Associations are our 
inspirations. 

 
Figure 1. PersonalBrain Interface 

Thoughts are Information 
PersonalBrain Thoughts can represent just about any type of information, 
including concepts, people, documents, spreadsheets, images, shortcuts, and 
Web pages. By letting you create links and associations between Thoughts, 
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PersonalBrain expands to become a visual interface that reflects the way you 
think. 

Using simple click-and-drag techniques, you’ll be able to create and navigate 
through networks of Thoughts in a conceptual space unique to your work habits. 
When you begin using PersonalBrain, you will find that your computer becomes 
easier to use—faster, more enjoyable, and less frustrating—helping you use your 
time more efficiently. 

Dynamic Graphical Interface 
PersonalBrain lets you create a simple, dynamic graphical map in which to input 
and navigate all your information. Your Brain starts with a single Thought, to 
which several other Thoughts can be visually linked. These Thoughts have their 
own links to other Thoughts and, possibly, to each other. PersonalBrain’s flexible 
structure allows any Thought to be linked to any other Thought, so you are never 
more than a few steps away from the information you are seeking. It’s simple to 
make connections between Thoughts so that they reflect the connections you 
make in your mind. 

Operating Systems 

PersonalBrain data is accessible from multiple platforms. The Brain file format is 
compatible across Operating Systems. PersonalBrain currently runs on 
Windows, Mac OS X, Linux, and Unix.  

About this Guide 

The following icons are used throughout this guide to flag categories of 
information: 

 
This icon is used to identify notes. 

 
This icon is used to flag tips and suggestions. 

PersonalBrain is offered in three editions—Free, Core, and Pro. Icons are used 
throughout the guide to flag features that are specific to the Core and Pro 
editions. Features that are available in all editions are not designated with a 
special icon. 

 

This icon is used to indicate that the feature is available in both the Pro and Core 
editions. (Note that all features available in the Core edition are also available in 
the Pro edition.) 

 

This icon is used to indicate that the feature is available in the Pro edition only. 
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PersonalBrain operates under multiple Operating Systems—Windows, Mac, and 
Linux/Unix. OS-specific features are flagged with icons throughout the guide. 
Features that are available for all Operating Systems are not designated with a 
special icon. 

 
This icon is used to indicate that the information applies only to computers 
running Windows 2000, XP, and Vista. 

 
This icon is used to indicate that the information applies only to computers 
running Mac OS X 10.3+. 

 
This icon is used to indicate that the information applies only to Linux/Unix. 

In addition: 

Labels Names of buttons, menus, commands, keys, and icons appear in this font 
throughout the guide in order to stand out. 

Note to Macintosh Users 

 Right-clicking: Most features in PersonalBrain can be accessed with just a 
single click of your primary mouse button. However, there are several context-
sensitive shortcuts available in context menus which appear when right-clicking. 
On a Macintosh, many systems do not have a right mouse button. To access a 
context menu, just hold down the Control key while you click. Note that many 
mice can be set up to interpret clicks on each side of the main button differently 
so that Control-clicking is not necessary. To enable this, alter the Mouse settings 
in the System Preferences area of your Mac. Select “Secondary Button” for the 
right side of the mouse. 

Brain Terminology 

Here is a list of working definitions for the basic terms used throughout 
PersonalBrain.  

 

Brain A collection of associated Thoughts, each of which can have 
content. You can create multiple Brains. 

Thought The topics that you link together in your Brain are called 
Thoughts and are the basic unit of a Brain. A Thought can 
represent anything you want it to. It can include an icon, notes, 
or one or more attachments (such as files and Web sites) or it 
can have no content at all and simply act as a subject heading 
or organizer. Minimally, a Thought has a name. 
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Plex The visible, graphical portion of your Brain that displays your 
Thoughts. 

Tools Window The portion of the Brain window that displays tabs for 
PersonalBrain’s seven Tools—Notes, Properties & 
Attachments, Tags, Details, Search, Reports, and Calendar. 

 
Figure 2. PersonalBrain Plex and Tools Window 

Active 
Thought 

The active Thought appears in the center of the Plex and is the 
current focus. The active Thought’s details are described in the 
Properties & Attachments tab and any notes you have 
entered for it appear in the Notes tab.  

 
Figure 3. What a Thought Looks Like 
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As shown below, when you click a Thought it moves to the center of the Plex and 
it becomes the active Thought.  

 
Figure 4. Activating a Thought 

Thought 
Relationships 

A Thought is said to be a “parent Thought,” “child Thought,” 
“sibling Thought,” or “jump Thought” based on its relationship to 
other Thoughts with which it is linked.  

In your own life, you may be someone’s parent, and someone’s 
child, and someone’s sibling, and someone’s peer, advisor, or 
colleague. So, who are you? The answer to that question is 
relative—it depends on the circumstances and what hat you’re 
wearing at the moment.  

 
Figure 5. Relationships are Relative to You 

The same applies to Thoughts. The relationships between 
Thoughts are displayed automatically, based on which Thought 
is active at the moment.  
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Whether a Thought is a parent, child, or sibling depends on its 
current relationship to the active Thought.  

 
Figure 6. Thought Relationships are Relative to the Active Thought 

Child Thought Child Thoughts are subtopics of the active Thought. They 
appear in the “child zone,” below the active Thought. In the 
picture above, the active Thought “Hobbies” has four child 
Thoughts. 

Parent 
Thought 

Parent Thoughts represent super ordinate topics or the active 
Thought. They appear in the parent zone, above the active 
Thought. 

Sibling 
Thought 

Sibling Thoughts share a parent with the active Thought. They 
appear in the sibling zone, to the right of the active Thought. In 
the picture above, “Entertainment” and “Family” are siblings of 
“Hobbies” because they are all children of “Personal.” 

Jump 
Thought 

Jump Thoughts are related to the active Thought but are 
neither child nor parent topics. They appear in the jump zone to 
the left of the active Thought. Jump Thoughts have an “equal 
weight” relationship with the Thought to which they are related. 
For example, as shown above, “Hobbies” has the various 
hobbies “Ballet,” “Banjo,” “Golf” and “Hockey” linked as child 
Thoughts since they are types of hobbies. “Budgets” affects the 
amount of resources available to spend on the various hobbies 
and so it is closely related, but it is not a hobby itself. 
Therefore, it makes a perfect jump Thought―related, but not 
part of the main Thought grouping. 

PersonalBrain User Guide 6 



 Introduction  

Gate Thoughts in the Plex have three circular “gates,” each of which 
is used to link a specific type of relation: The parent gate is 
above a Thought, the child gate is below it, and the jump gate 
is beside it. A gate is hollow when there are no links attached to 
it, and solid when one or more links are attached. Gates are 
highlighted in green when there are other Thoughts linked to 
them that are not currently visible. 

 
Figure 7. Thought Gates 

Link A link is the line that connects two Thoughts. When used as a 
verb, to “link” is the act of connecting Thoughts to establish 
close relationships.  

Opening Older Brains 

If you have been using a previous version of PersonalBrain you may want to 
download one of the transition guides (based on the version you’re most familiar 
with) at http://www.thebrain.com/manual. You will find complete information about 
what is new and different in the current version.  

When you’re looking at old and new Brain files, note that Brains created in 
PersonalBrain 5 have filename extensions of .brain. Brains created in some 
earlier versions have a .brn filename extension. To open a Brain that you created 
in an earlier version: 

1. Start up PersonalBrain 5. 

2. Click the File menu, click the Open command, navigate to the Brain of your 
choice, then click the Open button when the file is selected. The following 
message box will be displayed: 
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Figure 8. Convert Brain Message Box 

3. Click the OK button and PersonalBrain will begin the conversion process. 
The information will be stored in the same location as the original file. If an 
older .brn file was being converted, the original .brn file and .brn folder will 
not be affected. 

As PersonalBrain converts your Brain, you will see a running account of its 
progress. Upon completion, your converted Brain will appear in the Plex. 

 
Figure 9. File Conversion Progress Bar 

 
Brains are upwardly compatible—you may open (and convert) earlier Brains in 
PersonalBrain 5, however, PersonalBrain 5 Brains will not open in earlier 
program versions. 

Suggestions for Transitioning to Your New Brain 

Here are some tips for establishing a happy relationship with your Brain: 

 Begin by taking yourself on the guided tour provided in the next section of this guide. 
As you exit the tour, you’ll already have hands-on skills for getting your Brain up and 
running quickly and easily. You may also want to attend one of TheBrain’s free 
online seminars on getting started―PersonalBrain 101. To learn more about 
PersonalBrain 101, go to http://www.thebrain.com/pb101. 

 Avoid “converting” to a Brain-only environment all at once. Make the transition on 
a file-by-file basis so that every piece of information your Brain contains will be 
useful. 

 Build your Brain as you go—associating Thoughts as they occur naturally. 

 Avoid the temptation to move large folders into your Brain. PersonalBrain can 
handle this, but your Brain will be cluttered with Thoughts you may not need; 
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trying to create the proper links between relevant Thoughts could become a 
chore. 

Remember that your first Brain doesn’t need to be your only Brain or your last 
Brain. Experiment! Create a Brain just for fun, to try out the possibilities—give 
yourself room to stretch and explore. Your Brain is waiting! 

PersonalBrain User Guide 9 



 A Guided Tour of Personal Brain  

A Guided Tour of Personal Brain 

The best way to build your comfort level with your Brain is to build one yourself—
with your very own hands. This guided tour will walk you through the basics, 
pointing out items of interest along the way. There’s no need to take notes and 
you’ll never get left behind, because you’ll be going at the most strategic pace—
your own.  

  
During this tour, you’ll be asked to enter specific information to make it easier to 
refer to items and areas as the tour proceeds. Naturally, when you’re on your 
own, you’ll use your own ideas to create Brains that reflect your thinking. 

Here are the sign posts you’ll see along the way: 

 Enter here—the startup action for this phase of your guided tour 

 Point of interest—take out your virtual camera 

 Tip—where you can find more details about this step your guided tour 

 Take five—this is a good place to take a break if you want one 

 Exit here—this marks the end of your guided tour 

Let’s go! 

Part 1: Explore the PersonalBrain Window 

Itinerary: You’ll start up PersonalBrain, create a new Brain, and tour through the 
components of the PersonalBrain window. 

 Start up PersonalBrain, unless it’s already running. You can select PersonalBrain 
from the Start menu. 

 
Figure 10. Starting PersonalBrain 
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When PersonalBrain first starts and the last Brain can’t be re-opened or if you 
close the open Brain without opening a new one, a welcome screen is displayed. 
This screen shows:  

 Commands for creating a new Brain and opening an existing Brain 

 Links for opening the Brains you’ve opened recently 

 Links for accessing tutorials and the Support Center 

 A tip and navigation buttons for viewing the next and previous tip 

 Information about the edition of your Brain software and whether updates are 
available 

 
Figure 11. The Welcome Screen 

1. Click the New Brain button on the welcome screen (or click the File menu, 
then click the New Brain command). 

2. In the empty field, type: Tour 
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Figure 12. New Brain Dialog Box 

 Notice that the Location field displays the path of the folder in which your 
Brain will be created. You can use the Browse button to change the 
location, if necessary. 

3. Press the Enter key or click the OK button to finish creating a new Brain 
named “Tour.” 

 Your screen should look similar to this: 

 
Figure 13. The Parts of the PersonalBrain Window 

PersonalBrain creates your first Thought for you. It has the same name as your 
Brain (which you can change later if you want to). Since it’s the only Thought, it’s 
also the “active Thought”—the Thought that’s currently selected. 
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 The PersonalBrain Toolbar 

 
Figure 14. PersonalBrain Toolbar 

1. Point at each one of the buttons in the PersonalBrain toolbar so that you 
see a brief explanation in the pop-up tool tip. 

2. Click the Add Brain button to add “Tour” to the toolbar. Now you’ll be able 
to return to this Brain when any other Brain is open. 

 The PersonalBrain Tools 

 
Figure 15. A Note in the Notes Tab 

1. Click in the empty white space of the Notes tab in the Tools window, then 
type: My tour of PB. You’ve just created your first Note, which is 
associated with the “Active Thought”—Tour. 

  
There’s no need to save Notes, even if you activate other Thoughts or close your 
Brain. While your Notes are saved automatically, you can click the Save 
command on the File menu or press Ctrl-S to save if you want to. 

2. Click the Details tab to see the active Thought’s details. 

3. Click any of the other tabs if you want a quick peek.  

 Tip: See the section beginning on page 116 for details about working with the 
Notes Tool. 
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  Window Behavior Options 

1. Click the Window menu and note what the current selections are so you 
can return to them later if you want. 

2. Select one of the auto-hide options, then click outside of the PersonalBrain 
window. Notice that the PersonalBrain window is now hidden from view. 

3. Click the Brain button to reactivate your Brain. The button will be located 
on whatever side of the screen you selected via the auto-hide option. 

 
Figure 16. Display Personal Brain 

4. Click the Window menu, then click the Float command. Notice that now 
you can minimize, maximize, or restore the PersonalBrain window using 
standard Windows’ techniques. 

 Tip: See Customizing The PersonalBrain Window beginning on page 37 for 
details about controlling the behavior of the PersonalBrain window. 

Part 2: Create New Thoughts 

Itinerary: You’ll create a single Thought, multiple Thoughts, a Thought from an 
existing file, and a Thought “pin,” and modify the relationship between two 
Thoughts. 

 Your Tour Brain should be on the screen, as you left it in Part 1. 

1. The three circles surrounding the Tour Thought are called “gates.” The 
bottom circle is called the child gate because it provides a gateway towards 
creating a child Thought. Drag the mouse from the child gate down a short 
distance, then release the mouse button. The Create Child dialog will 
open. 

 Tip: If you prefer not to drag the mouse to create a Thought, right-click the Tour 
Thought and then click the Create Child command on the context menu. 
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Figure 17. Dragging from the Child Gate 

2. In the empty field, type: PB Buddies 

 This Thought will organize Thoughts about people you’re going to talk to 
about how they use PersonalBrain, so you can share experiences. 

3. Press the Enter key (or click the green button showing the check mark). A 
“pulsing” circle appears around a new Thought for a few seconds, 
highlighting it for easy visibility. Your Tour Thought now has a child Thought 
named “PB Buddies.” 

 Creating Multiple Thoughts at Once 

You can create more than one Thought at a time by typing a semicolon to 
separate each Thought. 

1. Create four new child Thoughts for Tour, all at the same time. To begin, 
drag Tour’s child gate down a bit, then release the mouse button. 

2. In the empty field, type: Tips; Reminders; To-Do; New Brain Ideas 

 
Figure 18. Multiple Thoughts at Once 

 Tip: The semicolon (;) between each Thought name tells PersonalBrain that 
these are separate Thoughts. 

3. Press the Enter key (or click the green button with the check mark).  
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 Create a Thought by Dragging and Dropping an Existing File 

You can create a Thought by dragging a file from the desktop or from your file 
manager (such as File Explorer on Windows or Finder on a Mac). The new 
Thought will have the same name as the file (minus its extension) and it will 
automatically have the file as an attachment. You’ll learn more about 
attachments in the next part of this tour. 

1. Choose any file, from your desktop or from any other location. Your original 
file will not be affected by being moved into your Tour Brain―you’re just 
creating a shortcut. 

2. Size the PersonalBrain window so that you can also see either the portion 
of the desktop containing the file you’re going to use or the window in which 
the file is listed.  

3. Drag the file into the Plex. 

 
Figure 19. File Dragged into Plex Becomes a Thought 

 The new Thought will appear in the Plex and it will include an icon that 
represents the type of file. Any time you click this icon in the Plex, the 
related file will open. 

   

If PersonalBrain is in auto-hide mode, dragging the file to the PersonalBrain icon 
opens the window automatically. See Customizing The PersonalBrain Window 
on page 37 for information about the different way the PersonalBrain window can 
operate. 

 

PersonalBrain User Guide 16 



 A Guided Tour of Personal Brain  

 Thought Pins 

 
Figure 20. Thought Pins in an Existing Brain 

The area at the top of the Plex, just below the PersonalBrain toolbar functions 
like a bulletin board on which you can “thumbtack” Thoughts you want to keep at 
your fingertips. These quick-access shortcuts to Thoughts are called “pins.” No 
matter where you are in the Plex, the pins remain visible.  

1. Right-click the Thought named Reminders, then click Create Pin on the 
context menu. 

2. Click any other Thought in the Plex. When you want to return to the 
Reminders Thought, click the Reminders pin to get there instantly. 

 Relationship Changes 

1. Create a new child of Tour named “Experiments.” (Drag from Tour’s child 
gate down a bit, type: Experiments and then press the Enter key.) 

2. Now you’ve decided that the Experiments Thought should really have an 
equal relationship with Tour, and not be one of its children—because you’ll 
use experimenting as much as touring to develop your Brain skills.  
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 Drag Experiments up to the left side of the Plex so that it is level with Tour, 
then release the mouse button. 

 
Figure 21. Dragging a Thought to Change its Relationship 

 Tip: See the section beginning on page 56 for details about changing Thought 
relationships. 

 This is a good place for a break if you’d like to take one. You can leave your 
Brain open or close the PersonalBrain window. Just start up PersonalBrain again 
when you’re ready to continue. 

Part 3: Find, Add Attachments, Link, and Delete Thoughts 

Itinerary: You’ll find Thoughts, add an attachment to a Thought, add a Web page 
to a Thought, use a Thought to open an application, link some Thoughts, and 
delete a Thought. 

 Your Tour Brain should be on the screen, as you left it in Part 2. You’ll begin by 
creating a few more Thoughts for a little more scenery along the way. 

1. Create four new child Thoughts under PB Buddies: John; Jill; Fred; Ann 
(Drag from PB Buddies’ child gate, then type each name, separated by a 
semicolon, then press the Enter key.) 
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Figure 22. Four New Thoughts 

 PB Buddies should be the active Thought—you should see the rotating 
active Thought indicator behind the Thought and it should be in the middle 
of the Plex. 

2. Enter a Note for PB Buddies: We should compare Brains sometime 

3. Point the mouse at the Tour Thought and notice how the Note changes. 
Then point back to the active Thought and see how the Note reflects the 
Thought being pointed to. 

4. Click the Reminders pin up at the top of the Plex to go quickly to your 
Reminders Thought. 

 Instant Activation  

“Instant Activation” is a PersonalBrain feature that lets you quickly find a Thought 
by typing a few letters, and choosing from a list of “hits.” After you click the 
Thought of your choice, that Thought is automatically activated. 

Say you’re ready to work with Fred’s Thought—you want to add an attachment to 
it. With such a small Brain, you could click around and find it pretty quickly, or 
you could speed things up: 

1. Click in the Search field and type: f 

 
Figure 23. Instant Activation 

 Because you only have one Thought that begins with the letter “f,” it is 
found instantly. If other Thoughts begin with the same letter you will see 
them in the box. The more characters you type, the more finely-tuned your 
search will become. 

2. Click on “Fred” in the one-item list above the Search field where you typed 
the “f.” Fred will be activated. 

3. Type the letter “j” in the Search field to activating Jill. Notice that the two 
Thoughts beginning with the letter “j” appear in the list. Activate Jill. 
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 Tip: See the Search section beginning on page 134 for details about more 
complex searching and the Navigating Your Brain section on page 30 for more 
on cruising around your Brain.  

 Attachments 

1. Back to Fred. Activate Fred by clicking his Thought. 

2. Click the Add Attachment button in the Properties & Attachments tab of 
the Tools window. 

 
Figure 24. Add an Attachment 

3. You can add an existing file or you can create a new one. For now, select 
an existing file on your computer. To do so, click the Link to File button. 

4. Navigate to any file on your computer, then click the Open button to attach 
it to the active Thought. 

 Notice that the filename appears in the Properties & Attachments tab’s 
list section. Now you can click on it at any time to open the file. You might 
use this function to add a photo of Fred, or a file you’re collaborating on, or 
notes about a project you’re completing together. 
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 Web Page Thoughts 

1. Activate the John Thought. 

2. Open your Internet browser and navigate to a Web page of your choice. 

3. Arrange the browser window and the Personal Brain window so that you 
can see at least part of both of them. 

4. Drag from the address bar icon in your browser to the active Thought 
(John), then release the mouse button. 

 
Figure 25. Inserting a Web Page as an Attachment 

A link to the Web page will be added to the attachment list and you can launch 
the page by clicking on it whenever John is the active Thought. Or, you can click 
the icon in the Thought whenever it is visible in the Plex, whether John is the 
active Thought or not.  
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 Tip: If you want to create a new Thought for the Web page instead of adding it to 
existing Thought, just drag and drop the page icon to a blank area of the Plex 
and a child Thought will be created. See the Adding Files, Web Pages, and 
Folders section beginning on page 83 for details about attachments. 

 Creating Attachments from a Thought 

1. Activate the New Brain Ideas Thought by typing an “n” in the Search field 
and then clicking on “New Brain Ideas” in the list. 

2. Click the Add Attachment button. 

3. Click Microsoft Office Word Document (assuming this application is 
installed on your computer—if not, select any other application in the list). 

  
If you are not using Windows, there will not be any automatically created 
file types to select from. To create files from within PersonalBrain, you’ll 
need to add some file templates first: 

 Click the Templates… button to open the folder where templates are 
stored, then copy empty files of the types you want to be able to create 
from within PersonalBrain into the folder.  

 When you are done, click the Add Attachment button again and chose 
one of the templates you added. 

Once you select a file type, two things will happen:  

 First, a new file will be created and added to the Thought (in this 
example, a Microsoft Word document named “New Brain Ideas”). 

 Second, the file will be automatically opened so that you can work on it 
(in this case, starting Microsoft Word).  

After you add content to the document and save it, it will be saved internally 
within your Brain. When you click on the Thought, the document will open 
again. 

4. Close the document before moving on to the next section. 
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 Linking Thoughts 

One of the most powerful features of PersonalBrain is the ability to connect 
Thoughts to each other. Remember, you can connect any Thought to any other 
Thought. For example, say one of your PB Buddies, Ann, is full of ideas on how 
to use your Brain. You might want to link her to the New Brain Ideas Thought. 

1. Activate the New Brain Ideas Thought. 

2. Drag from the jump gate on the left side of New Brain Ideas as if you are 
going to create a new jump Thought and release the mouse button. 

 

3. Type the first few letters of the Thought you want to connect (Ann) in the 
Create Jump dialog box. Notice that the existing Thought is displayed in the 
list below. 

 

4. Select the existing Thought from the list and then click the check mark. 

 
Figure 26. Jump Thought Linked to an Existing Thought 
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Now that Ann is connected to New Brain Ideas, whenever you look at this 
Thought, her Thought will be just a click away. Also, when you are at Ann’s 
Thought, the New Brain Ideas Thought will be conveniently available. 

There are many ways to link existing Thoughts. The method above is convenient 
when the Thoughts you want to connect are not both visible, however if the 
Thoughts are both visible, you can simply draw the link between the two, starting 
from the either one of the Thought’s gates. Both the Past Thought List below the 
Plex and the pins can be used for linking Thoughts visually. When you connect 
two Thoughts visually, the resulting relationship will be determined by which gate 
you selected to start the linking―it does not matter where you release the mouse 
button over the destination Thought. 

 Forgetting and Deleting Thoughts 

If you’ve entered a Thought in error or you simply don’t need to keep it around 
anymore, you can easily remove it from your Brain. PersonalBrain offers two 
ways to remove Thoughts, forgetting and deleting. When a Thought is forgotten, 
it can be remembered later if need be, however deleting is permanent. 

Let’s forget the Thought Jill. 

1. Make PB Buddies the active Thought. 

2. Right-click the Jill Thought. 

3. Click the Forget command on the context menu. 

Jill disappears from the display. Now, if you want to show Jill again, turn on 
Forgotten Thoughts. 

 Click the Options menu, then click Show Forgotten Thoughts. 

The Forgotten Thoughts dialog box can be used to permanently delete 
Thoughts or remember them. To turn off the display of forgotten Thoughts again, 
simply close the dialog box. 

 Tip: If you want to permanently delete a Thought without first forgetting it, hold 
down the Shift key as you right-click on it and then select the Delete command. 
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Concluding Your Tour 

If you click the Home button in the PersonalBrain toolbar, your Brain should look 
something like this: 

 
Figure 27. Completed Tour 

Where to go from here? You can stay and experiment more with your Tour 
Brain, begin reviewing sections of interest throughout this guide, or dive into 
creating your own Brain. You may want to glance at some of the examples in 
Some Sample Brain Applications, beginning on page 172, for more ideas—but 
you probably already have plenty of your own! 

 Tip: If you are ready to dive into beginning your own Brain, start by creating a 
few Thoughts for broad categories before you go to the detail level. For example, 
if your name is Ed, “Ed’s Brain” might be the name of your Brain (and your first 
Thought) and its first children might be Work, Family, Hobbies, and Friends. 

 This concludes your guided tour—-thanks for coming along! 
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Understanding Thought Relationships 

There are no rules governing the relationships between Thoughts—whatever 
makes sense to you is the way your Brain ought to be organized. The three 
primary relationships types―child, parent, and jump―can be used to express 
different types of relationships. Sibling is a relationship that is derived from 
child/parent relationships.  

The examples in this section can help you understand the variety of relationships 
and how they are used. The core concepts behind each type of relationship are 
as follows: 

 Children: Child relationships are usually used to link more specific 
information or information that represents a subcategory. 

 Parents: Parent relationships are usually used to link more general 
information. Parents can also be thought of as higher level categories to 
classify groups of information. They serve to indirectly connect their child 
Thoughts as siblings. 

 Jumps: Jump relationships are usually used to link two pieces information 
that are exclusively related, meaning that the two items are related to each 
other but neither represents a group that the other is a part of. 

Let’s move on to an example to explore these relationship types. Imagine that 
you are the owner of a company and you are reviewing personnel files. Each 
employee has a file. You decide it makes sense to organize your employees by 
department. Your PersonalBrain is called My Brain. From My Brain, you create a 
child Thought called My Company (see Figure 28). My Brain is now My 
Company’s parent Thought. You create four child Thoughts from My Company—
Manufacturing, Sales, Service, and Billing. These departments are sibling 
Thoughts of each other. 

 
Figure 28. Sample PersonalBrain 
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Now you go to each department and create more child Thoughts, one for each 
employee of the department. If an employee splits time between two 
departments, you can make him a child Thought of both departments—he’ll 
appear in both and you won’t have to duplicate his file. In this example, Bob is a 
child Thought of both Manufacturing and Sales (see Figure 29). This is one of the 
most powerful features of PersonalBrain—having one Thought under more than 
one heading. 

  
Figure 29. Child Thought Link to Two Headings 

If you own more than one company, but have one accountant for all of them, you 
might want to make a Thought called Accountant and link it as a jump Thought to 
each company (see Figure 30). 

 

 
Figure 30. Jump Thoughts to the Active Thought 
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Imagine that Joe’s company has just purchased one of your companies. Since 
Joe’s company now owns this company, Joe’s Company becomes a parent (see 
Figure 31). 

 

 
Figure 31. New Parent Thought 

Because Joe wants to avoid a conflict of interest, the acquired company (My 
Other Company) no longer uses the same accountant. So its jump gate is hollow, 
while its sibling’s jump gate (My Company) maintains that Link and is filled. 

As you use PersonalBrain, you will develop a sense of the types of relationships 
you wish to make between Thoughts. It is always possible to change 
relationships (see Changing Relationships on page 70). 

Families of Thoughts 

It is tempting to view Thought relationships as families, and indeed these 
different parts of your Brain are types of families, with their ancestry visually 
spread before you, represented by subjects and categories. But unlike human 
families, a child Thought can be a parent of one of its siblings and a Thought can 
have more than two parents. 

The complex relationships you can form in PersonalBrain are the source of its 
power. Let’s consider sibling Thoughts that also share a parent/child relationship. 

Let’s say you are studying philosophy. You might have a Thought called 
Philosophy (see Figure 32). Individual philosophers such as Plato and Aristotle 
could be child Thoughts of Philosophy. Each of these siblings, in turn, may have 
child Thoughts. Aristotle was a student of Plato, so you may want to make 
Aristotle not only a child of Philosophy, but of Plato, so that when you’re working 
with Aristotle, Plato is only a Thought away. 

PersonalBrain User Guide 28 



 Understanding Thought Relationships  

 

 
Figure 32. Example of Parent/Child Relationships 

Notice that when Philosophy and Plato are in Aristotle’s parent zone, their 
relationship (Philosophy is a parent Thought of Plato) is shown by the line linking 
the child gate of Philosophy to the parent gate of Plato.  

Clearly, PersonalBrain is a powerful method of organizing ideas and information. 
No hierarchical file structure can provide as much cross-referenced information 
at a glance. And our example is pretty basic—a fully developed Brain can hold 
many more relationships and much more information. 
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Navigating Your Brain 

All Thoughts can be connected—directly or indirectly—even Thoughts that may 
seem to have nothing to do with each other are can be related through a chain of 
links.  

Let’s look at an example, say, the Queen of England and asparagus. You have a 
Thought called Queen of England. One of its child Thoughts is Prince of Wales, 
which a parent Thought Famous Princes that is also linked to the story of the 
Frog Prince. The story has another parent Thought called Fairy Tales. A sibling 
of Frog Prince is Jack and the Beanstalk, which has child Thoughts called Giant 
and Jack. Giant has another parent Thought called Famous Giants, which has a 
child Thought called Jolly Green Giant. Jolly Green Giant has child Thoughts 
named after canned vegetable products, one of which is Asparagus. Figure 33 
illustrates this series of connections. 

 
Figure 33. The Queen of England’s Connection to Asparagus 

Depending on the relationship you create between them, Thoughts may be 
closely or distantly related. Thoughts are considered to be closely related when 
they are linked directly or are siblings. In the default view of the Plex, only close 
Thoughts of the active Thought are always displayed in the Plex. Thoughts that 
are one additional step (generation) away from the active Thought can be 
displayed using the “Expanded Thoughts” view. In Figure 33, many distant 
Thoughts are displayed using the “Expanded” view. See Advanced Navigation 
and Alternate Views on page 97 for information about the different view options. 

PersonalBrain User Guide 30 



 Navigating Your Brain  

Opening Content 
As you navigate through your Brain, you can open the attachments associated 
with a Thought in two ways: directly from the Plex by clicking on the Thought’s 
icon, even if it is not the active Thought, or by double-clicking the attachment in 
the Properties & Attachments tab. 

Previewing Thought Content 
The content of the Properties & Attachments and the Notes tabs automatically 
updates to show content related to the active Thought, or the Thought your 
mouse pointer is currently over. This feature can be used to preview the content 
associated with a Thought before activating it. (If you prefer, this feature can be 
turned off by deselecting the “Update tools on mouseover of Thoughts” check 
box in the UI section of the Preferences dialog box.) In the example below, My 
Latest Preoccupations is the active Thought, but the content in the Properties & 
Attachments tab (below the Plex) belongs to Chocoholics Anonymous, where 
the mouse is pointing.  

 
Figure 34. A Word File for an Inactive Thought 

As your Brain grows and becomes more complex, this preview feature can be a 
big time saver. Additionally, you can navigate and explore more efficiently by 
using pins, the Past Thought List, and Instant Activation (explained below). 
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Pins 
As you saw if you went along on the Guided Tour of PersonalBrain earlier, pins 
are shortcuts to Thoughts to which you want quick access. They appear at the 
top of the Plex, just below the PersonalBrain toolbar. No matter where you are in 
your Brain, the pins remain visible. 

 
To create a pin: 

 Right-click the Thought for which you want to create a pin, then click Create 
Pin on the context menu 

 
Figure 35. Creating Pins 

To remove a pin: 

 Right-click the pin or on a Thought that has a pin, then click Remove Pin on 
the context menu 

 
Removing a pin does not remove or delete the associated Thought, just the 
reference to it at the top of the Plex. 
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To use a pin to link Thoughts: 

 Drag from one of the Thought gates to the pins, or 

 Move your mouse pointer over a pinned Thought and gates will appear; drag 
from one of these gates to the Thought you want to link 

Activating Recent Thoughts: The Past Thought List 
You can think of the Past Thought List as the visual representation of the phrase, 
“train of thought”—a scrollable list of Thoughts in the order you activated them. 
The Past Thought List is displayed at the bottom of the Plex window. 

PersonalBrain keeps a running “breadcrumb” trail of your Thoughts based on 
activation and displays it in the Past Thought List at the bottom of the Plex. 
Clicking on any Thought in the Past Thought List activates that Thought. Also, 
when a new Thought is created it appears in the Past Thought list immediately 
(unless multiple Thoughts were created by using the “semi-colon trick“ or via an 
imported outline, in which case only one of the Thoughts will automatically 
appear in the Past Thought list).  

 
Figure 36. Past Thought List 

Scroll arrows displayed as triangles are located to the left and right of the Past 
Thought List when there are additional Thoughts available in that direction. Use 
them to navigate sequentially through past Thoughts, from the first Thought 
you’ve activated to the last.  

The most recently activated Thought (the current active Thought) appears at the 
right end of the list. As with pins, if you hold the mouse over the name of a 
Thought in the Past Thought List, the name is highlighted and expanded, if 
necessary, for easier reading. If a Thought in the list has a file or Web page 
attached, the icon for the file’s application appears to the left of the Thought.  

To use a Thought in the Past Thought List to link Thoughts: 

 Drag from one of the Thought gates to one of the Thoughts in the Past 
Thought List, or 

 Move your mouse pointer over a Thought in the Past Thought List and gates 
will appear; drag from one of these gates to the Thought you want to link 
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In the example below, Sharon is going to become a child Thought of Causes; the 
mouse has being dragged from the child gate of Causes to Sharon. 

 
Figure 37. Creating a Link from the Past Thought List 

Using the Back and Forward Buttons: 

 In addition to the Past Thought List, you can also use the Back and Forward 
buttons, located near the top of the Window, to quickly retrace your steps; 
these buttons work just like they do in a Web browser 

 

 Click the Back button to go back to the last active Thought 

 Once you have clicked the Back button, the Forward button can be used to 
re-activate the Thought you came from 

 
Back and Forward Mouse Buttons: The back and forward buttons available on 
some mice (typically on the left side of the mouse near where you place your thumb) 
may be used to navigate backward and forward in your Brain. These mouse buttons 
perform the same navigation as the Back and Forward buttons in the PersonalBrain 
toolbar, shown above. 

Instant Activation 

You can quickly scan the results of the Instant Activation as you type in the 
Search box—they appear just above your typing. To activate one of these 
results, click it with your mouse or use the up-arrow, down-arrow, page up, and 
page down keys on the keyboard then press the Enter key.  
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The search includes every word in Thought names. Results are displayed 
starting with first word matches and are prioritized based on how recently they 
have been activated.  

 
Figure 38. Instant Activate Uses All Words Within Thought Names 

 

Accents are ignored when matching Thought names. Also, when two or more 
matches with the same name are found, the names of their parent or jump 
Thoughts are also displayed so you can differentiate them. 

You can search for Thoughts by typing the first letter(s) of separate words and 
the letters can be in any sequence; for example, to find the “Family and Friends” 
Thought you could type “fa fr,” or “fr fa,” or “fa and fri,” or even “f a f.” 

 
Figure 39. Use First Letters of Separate Words for Instant Activate 

In addition to the results that appear as you type, you can do a full search of all 
the content of your Brain by clicking the Search button or pressing the Enter key 
once you have entered the word or phrase you are looking for. 

 

For more information about advanced navigation, please see the Advanced 
Navigation and Alternate Views section beginning on page 97. 
For more information about searching your Brain, please see the Search section 
beginning on page 134. 
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Customizing Your Brain’s Environment 

You may choose to use your Brain just as it’s offered “out of the box” or you may 
choose to change some of the environmental settings to suit your personal 
preferences. 

PersonalBrain’s Default Settings 

Without making any changes, here’s what your Brain looks like: 

 The PersonalBrain window will behave like a regular window. This is called 
the “Float” window option. 

 The area where your Thoughts appear (the Plex) will be shades of dark blue 
with white text and blue links—this is the default “Theme.” 

 The top half of the PersonalBrain window will display your Thoughts and the 
bottom half of the window will display a set of tabs (which are PersonalBrain 
“Tools”). 

 Your Thoughts will be displayed in “Normal” view, meaning that you will see 
only the direct parents, children, jumps, and siblings of the active Thought. 

 
Figure 40. PersonalBrain Window with Default Settings 

PersonalBrain User Guide 36 



 Customizing Your Brain’s Environment  

Customizing The PersonalBrain Window 

 There are three basic options for how the PersonalBrain window behaves: 

 As a standard window that can be minimized, maximized, restored, and 
dragged by its title bar to different locations on the screen (the Float option) 

 As a standard window that will always appear on top of any other open 
windows (the Float option plus the Always on Top option) 

 As a window that automatically hides when not in use and appears in a 
designated location when you click an icon (the Auto-hide option) 

To make your Brain float: 

 Click the Window menu, then click the Float command. 

To make your Brain always stay on top of the desktop or any other window: 

 Click the Window menu, then click the Always on Top command. 

To make your Brain automatically hide when not in use: 

1. Click the Window menu, then click either the Auto-hide Left, Auto-hide 
Right, Auto-hide Top, or Auto-hide Bottom command. 

2. When you click outside of the PersonalBrain window, your Brain is reduced 
to a Brain icon that appears in the side of the screen you selected in Step 1. 
Click the icon to unhide your Brain. 

 
If you are using multiple monitors, you can only auto-hide PersonalBrain on your 
main monitor. 

 
Figure 41. Icon for Unhiding Your Brain 

 Tip: You can drag the icon to any area of the screen’s border. 

Maximizing and Restoring the Plex 

 Maximize the Plex: Double-click any blank area of the Plex (hiding the Tools 
window). 

 Restore the Plex: Double-click any blank area of the Plex (restoring the 
Tools window). 
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Moving and Resizing the Plex 
When the default settings are in use and the Plex is in “Normal” view, you can 
move the Thoughts in the Plex up or down by dragging (up or down) in any blank 
area of the Plex background. 

 
Figure 42. Dragging the Plex Vertically  

To change the size of the Thought’s text, you can either move the mouse wheel 
up or down while hovering over the active Thought or you can drag the resizing 
circle behind the active Thought.  
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Figure 43. Before and After Dragging the Resizing Circle 

Customizing Your Brain’s Appearance 

Themes 
The Themes feature lets you choose from several built-in designs to customize 
the look of your Brain. In addition, you can save the look of your Brain as a new 
Theme and quickly switch from one saved Theme to another. 

 
Figure 44. Sample Themes 
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To select a Theme: 

1. Click the Options menu. 

2. Click the Set Themes command, then click the Theme of your choice. 

 
Figure 45. Selecting a Theme 

The Theme you selected will be applied. If you aren’t pleased with the result, 
select a different theme. Note that the default Theme (Dark Blue) can be selected 
from the menu. 

All of the options that are contained in a Theme can also be adjusted individually 
as described below. Once you have adjusted the look of your Brain, you can 
save it as a new Theme for easy access or to use with other Brains: 

1. Click the Options menu. 

2. Click the Save Themes As command. The following dialog box will be 
displayed: 

 
Figure 46. Save Theme Dialog Box 
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3. Type a name for the new Theme, then click the OK button.  

The Theme will be listed on the Set Theme sub-menu the next time you open it. 

 
Figure 47. Newly Saved Theme on Set Theme Menu 

 
To return to the original appearance of the Plex at any time, set the Theme back 
to “Default (Dark Blue).” 

Wallpaper 
To select an image to use as Wallpaper: 

1. Click the Options menu. 

2. Click the Select Wallpaper command, navigate to the location of your 
Wallpaper file, and then click the Open button. Supported wallpaper file 
formats include .jpg, .gif, and .png. 

To dynamically select new Wallpaper from a Web site: 

1. Go to a Web site that offers Wallpaper files, right-click the design of your 
choice, then select Copy on the context menu. 

2. Return to your Brain, right-click in any blank area of the Plex, then select 
Paste Wallpaper on the context menu. 
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Figure 48. Context Menu on the Plex 

 
After you select your Wallpaper you may want to adjust your Thought colors and 
links. See “Setting Other Preferences” on page 43. 

PersonalBrain Toolbar 
You can customize the PersonalBrain toolbar by adding (or removing) buttons 
that, when clicked, close the active Brain and open the designated Brain.  

 Click the Add Brain button to insert a button for the active Brain. Note that 
the Add Brain button will only be enabled if there isn’t already a toolbar 
button for the active Brain. 

 Click the Remove Brain button to remove the button for the active Brain 
(assuming the button has been added previously). Note that the Remove 
Brain button will only be enabled if there is a toolbar button for the active 
Brain. 

 
Figure 49. Modifying the Toolbar 

In addition to adding and removing buttons to the toolbar, you can also hide the 
toolbar if you do not plan on using it. Use the Show Toolbar command on the 
View menu to toggle the toolbar on or off. 
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Setting Other Preferences 
PersonalBrain’s Preferences dialog box is where you’ll find many of the settings 
for adjusting how your Brain works, both mechanically and visually.  

To open the Preferences dialog box: 

 Click the Options menu, then click the Preferences command (under Mac 
OS, the Preferences command is located in the PersonalBrain menu), or 

 Right-click a blank area of the Plex, then click the Preferences command on 
the context menu 

 
Figure 50. Two Methods of Accessing Preferences 

The choices you can make within the Preferences dialog box are explained on 
the following pages. 
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General Preferences 

 

The General settings affect how PersonalBrain works globally―no matter which 
Brain is open when you make your choices. 

 
Figure 51. General Section of the Preferences Dialog Box 

User 

 Entries in the User name and Email address fields identify the person 
behind your Brains. 

General Options When selected … 
Open PersonalBrain when 
Windows Starts 

PersonalBrain launches automatically when 
Windows opens. 

Check for major program 
updates at startup 

A notice appears if there is a new major 
program update available. 

Show Java update A notice appears if your computer is using an 
outdated version of Java. 

Show indexing libraries 
update 

A notice appears if your computer is missing 
the indexing libraries. 

Save images from the 
Internet locally 

PersonalBrain saves images pasted into notes 
from the Internet as local files. 

Show memory usage in 
toolbar 

PersonalBrain’s memory usage is displayed in 
the toolbar. 
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Hot Key 
 When Enable Hot Key is selected, pressing the key combination indicated in 

the fields to the right opens PersonalBrain instantly. By default, the hot key is 
Alt+Shift+Z, but you can use these fields to specify a different combination. 

Look & Feel Preferences 

 

With the exception of wallpaper and font settings, the Look & Feel settings affect 
how PersonalBrain works globally―no matter which Brain is open when you 
make your choices. Wallpaper and font settings affect only the Brain that is open 
when you make your choices. 

 
Figure 52. Look & Feel Section of the Preferences Dialog Box 

Thoughts Options When selected … 
Text Shadows Displays a drop shadow behind each Thought 

using the color selected in the Colors section 
of the Preferences dialog box. 

Backgrounds Includes draws a colored background behind 
all Thoughts using the color selected in the 
Colors section of the Preferences dialog box. 

Load thumbnails for large 
images 

Large image attachments are loaded as 
thumbnails and displayed as zoomable icons. 

Apply colors to Determines whether the color selected in the 
Display properties for an individual Thought 
will apply to the Thought’s text or background. 

PersonalBrain User Guide 45 



 Customizing Your Brain’s Environment  

Thoughts Options When selected … 
Fade distant Distant Thoughts gradually fade when in 

Expanded or Outline view. 
Shrink in outline and 
expanded view 

Distant Thoughts gradually shrink when in 
Expanded or Outline view. 

Show icons when notes are 
present 

Plex displays a small yellow notepad next to 
all Thoughts that contain notes. 

Hide tag hints When selected, tags are not shown next to 
Thoughts in the Plex. 

 
Plex Options When selected … 
Wallpaper/Wallpaper.png The currently-selected image will fill the Plex, 

behind your Thoughts; if no image is in use, 
selecting this check box opens the Select 
Wallpaper dialog box as does clicking the 
associated Change button when there is an 
image in use. 

Tile wallpaper Wallpaper image appears replicated in 
squares (“tiles”) instead of a single image 
filling the Plex. 

Active Thought indicator The rotating active Thought indicator displays. 
Draw links Liinks between Thoughts are displayed 

(otherwise a link displays only when the 
mouse hovers over it). 

Thicken highlighted links A link appears thicker when when the mouse 
hovers over it. 

Show welcome message A scrolling "Welcome to TheBrain" message 
displays at startup. 

Maximum child columns 
(normal view) 

The number selected dictates the maximum 
number of columns for child Thoughts when in 
Normal view mode. 

Animation 
 Drag the slider right to reduce or left to increase the speed with which a 

Thought becomes active when you click it in the Plex. 

Font 
 Use the drop-down list to select a font for all Thoughts in the Plex. 
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Color Preferences 

 

The Color settings affect only the Brain that is open when you make your 
choices. You can specify the default colors for every item. 

 
Figure 53. Colors Section of the Preferences Dialog Box 

Item Description … 
Thoughts, backgrounds Default color of a Thought's background (if 

“Backgrounds” is selected in the Look & Feel 
section). 

Thoughts, selection outline Color of the outline of selected Thoughts. 
Thoughts, text Default color of the text of Thoughts. 
Thoughts, text (forgotten) Color of text for forgotten Thoughts. 
Thoughts, text (private) Color of text for private Thoughts. 
Thoughts, text shadow Color of the shadow behind the text of 

Thoughts (if “Text Shadows” is selected in the 
Look & Feel section). 

Active Thought, outline Color of the outline for the active Thought. 
Active Thought, resizing 
circle 

Color of the resizing circle around the active 
Thought. 

Active Thought, rotating 
indicator 

Color of the rotating active Thought indicator 
(if “Active Thought indicator” is selected in the 
Look & Feel section). 
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Item Description … 
Background, center Color of the background in the center of the 

Plex if no wallpaper is in use. 
Background, top and bottom Color of the background on the top and bottom 

of the Plex if no wallpaper is in use. 
Gates, highlighted Color of the gates used to indicate that there 

are linked Thoughts connected that are not 
currently visible. 

Gates, normal Color of gates that lead to another visible 
Thought. 

Highlighted Thoughts, 
background 

Color of the background of a highlighted 
Thought. 

Highlighted Thoughts, 
outline 

Color of the outline of a highlighted Thought. 

Links, highlighted Color of the link between Thoughts when 
highlighted. 

Links, normal Color of links between Thoughts. 
Messages, background Color of the background of a Brain message. 
Messages, outline Color of the outline of a Brain message. 
Messages, text Color of the text of a Brain message. 
Scrollbar, fill Color of the interior of a Plex scroll bar. 
Scrollbar, highlighted Interior color of the Plex scroll bar when 

highlighted. 
Scrollbar, outline Color of the outline of a Plex scroll bar. 
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UI Preferences 

 

The UI settings affect how PersonalBrain works globally―no matter which Brain 
is open when you make your choices.  

 
Figure 54. UI Section of the Preferences Dialog Box 

General User Interface When selected … 
Mouse wheel resizing Font size in the Plex can be made larger or 

smaller adjusted using the mouse wheel when 
pointing at the active Thought. 

Click active Thought to 
open/create 

Clicking on the active Thought will open its 
attachment (or the Add Attachment dialog 
box if the Thought currently has no 
attachment). 

On drag and drop of files to 
PersonalBrain 

“Link to dropped files” causes attachments to 
maintain a link to the originals when dragged 
and dropped into PersonalBrain. 
“Move dropped files” causes attachments to 
relocate when dragged and dropped into 
PersonalBrain. 

Update tools on mouseover 
of Thoughts 

Tools will display the content for any Thought 
that the mouse is hovering over; otherwise, 
tools always display content for the active 
Thought. 
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General User Interface When selected … 
Automatically capitalize 
Thoughts on creation 

Capitalizes the first letter of each word in a 
Thought name when a new Thought’s name is 
entered in all lower case; this excludes articles 
such as “a” and “the” within the name. 

Show virtual Thoughts for 
folders 

Subfolders of linked folders are displayed in 
the Plex. 

Activate last created 
Thought 

A newly-created Thought automatically 
becomes the active Thought. 

Hide pins in presentation 
mode 

Pins are temporarily hidden while your Brain is 
in Presentation mode. 

 
Expanded View When selected … 
Collapse on activate Clicking on a Thought will hide Thoughts that 

are not connected to the clicked Thought; 
otherwise, all Thoughts remain visible unless 
they are manually hidden using the collapse 
controls (while in Exanded view). 

Automatically recenter Places the active Thought in the center of the 
Plex automatically (while in Exanded view). 

 

ESP Sync When selected … 
Monitor keyboard PersonalBrain checks what is being typed in 

other applications and looks for matching 
Thoughts to suggest or activate (not currently 
available in a Windows Vista environment). 

Monitor clipboard  PersonalBrain checks the content of the 
clipboard for the names of Thoughts or linked 
attachments to suggest or activate their 
Thoughts. 

Ignore text that is all 
lowercase 

Will not engage the ESP Sync feature if the 
relevant text is comprised of all lowercase 
letters. 

Cancel if not used within 1 
minute 

Cancels the ESP Sync feature, returning to the 
previous state if not used within the first 
minute of activation. 

Activation “Suggest only” instructs ESP Sync to display 
the matching Thought name in the Plex as a 
suggestion instead of actually activating the 
matching Thought . 
“Automatically activate” causes a Thought 
found by ESP Sync to become active 
automatically. 
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Search Preferences 

 

The UI settings affect how PersonalBrain works globally―no matter which Brain 
is open when you make your choices.  

 
Figure 55. Search Section of the Preferences Dialog Box 

Search When selected … 
Merge Thought and content 
results 

All search results will be merged into one large 
group. 

Only display one search 
result per Thought 

If both the Thought name and the content 
have a search result, the Thought will only 
show up once in the search results list. 

Index File attachments All file attachments (external links and 
internally stored) will be indexed when 
possible. 

Index URL attachments All URL attachments will be indexed when 
possible. 

 
Additional Search Instructions 
Results per page Select the number of search results to display 

per page (10, 25, or 50). 
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Additional Search Instructions 
Default sort “Relevance” sorts based on the density of 

matching terms and other criteria. 
“Date modified” sorts based on when the items 
were most recently modified. 

Maximum file size to index Select the maximum size allowed for a file to 
be indexed (1 MB, 3 MB, 5 MB, 7 MB, 10 MB, 
15 MB, 20 MB, or 25 MB). 

Refresh Web pages index Select how often to refresh the index for URL 
attachments (Never, Daily, Weekly, or 
Monthly). 

Filter under active up to n 
clicks away 

Select how many generations below the active 
Thought that PersonalBrain will search when 
using the “Only Under Active” search filter (3, 
5, or 7). 
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Creating Thoughts 

Creating a Single Thought 

There are four ways to create a Thought, but each starts with the same step—
choosing the Thought with which the new Thought will have a relationship. You 
will use the chosen Thought as a starting place when creating the new Thought.  

 
When you create a Thought in your Brain, you first decide what relationship it will 
have with an existing Thought—will it be a parent, child, or a jump Thought? 

Generally speaking, you’ll create child Thoughts more often than parents or 
jumps. There are certainly exceptions, but usually, using a “top-down” approach 
is helpful if you are just getting started: Create children (and jumps, as 
appropriate) and let parents happen naturally. 

Once you have activated the Thought that will have a relationship with your new 
Thought, use any of these techniques to begin creating a new Thought: 

 Click the Thought menu, then click the Create Child, Create Parent, or 
Create Jump command  

 

 Or, press the F6 key (for a child Thought), F7 (for a parent Thought), or F8 
(for a jump Thought)  

 Or, right-click the Thought, then click the Create Child, Create Parent, or 
Create Jump command 

 

 Or, drag from the Thought’s parent, child, or jump gate 
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Figure 56. Gates to Drag for Creating Thoughts 

 Tip: We recommend using the drag method—it’s the quickest! 

No matter which method you use to begin creating your new Thought, the next 
thing you’ll see is a field for typing in the name of your new Thought. (The field 
will be labeled according to the type of Thought you’re creating.) 

 
Figure 57. Create Child Dialog Box 

1. Type the name of your new Thought in the field provided. 

2. Press the Enter key or click the green check mark button to save your new 
Thought (or click the X button to cancel the process).  

 

Automatic initial-capitalization: If you type a Thought name using all 
lowercase letters, the first letters of words will be capitalized for you 
automatically. PersonalBrain uses “smart rules” to determine which words should 
be lowercase (such as “a,” “and,” and “of”). For example, if you’ve typed “visit the 
statue of liberty” the Thought title will automatically become “Visit the Statue of 
Liberty.” This feature is active, by default, but you can turn it off in the Options 
tab of the Preferences dialog box. 

Creating Multiple Thoughts at Once 

PersonalBrain offers a timesaver (affectionately known as the “semi-colon trick”) 
for creating more than one Thought at a time. There is virtually no limit to the 
number of Thoughts you can create at the same time. 

 Type a semicolon (;) to separate multiple Thought names in the Create 
dialog box 
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Figure 58. Creating Multiple Thoughts 

Creating Context-Sensitive Thought Names Using Commas 
It’s always good to be specific with your Thought names. PersonalBrain has 
some time savers to help you if you have repetitive information that needs to be 
added to your Brain. For example, say you have Thoughts for each of your 
clients, each of which has a billing department. You’d like a child Thought named 
“Billing Info” for each of your client Thoughts. However, you may not want to 
have identical Thought names because when you see these Thoughts later you 
won’t be able to tell them apart without looking at their parents.  

To remedy this potential dilemma, when you type the name of the new Thought, 
start or end the name with a comma. The parent Thought name will be added 
automatically. When this Thought is displayed, its name will vary depending on 
the context in which it’s viewed. If the client Thought is active, the client’s name 
will be hidden and it will appear as just “Billing Info.” But when you activate this 
Thought, the full name along with the client’s name will appear. 

 
Figure 59. Sub-Category Thoughts 

The Thought will display its full name when it is active. When its parent Thought 
is active, you’ll see only the portion of the name that does not repeat the parent’s 
name. Ensuring that each of your Thoughts has a unique name will help find and 
identify them more easily. 
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 Tip: The part of the Thought’s name that is hidden is context sensitive. Say for 
example that you wanted to have a single place to see the billing information for 
all your clients. You might create a Thought called “Billing Info” and then link to 
the billing information Thoughts for each of your clients, such as “NewGuys, 
Billing Info.” If you do this, when Billing Info is active then NewGuys, Billing Info 
will appear as just NewGuys, whereas when NewGuys is active, that same 
Thought will appear as Billing Info. Try it―you’ll see how this can be very useful. 

Swapping a Thought’s Name with its Label 
You can swap a Thought’s name with its label by clicking the Switch button in 
the Properties & Attachments Tool tab. This can be very useful when the 
default label and name are assigned based on a URL and the automatic naming 
isn’t optimal for your purposes. 

 
Figure 60. Swapping Label and Thought Names 

Copying Thoughts Within and Between Brains 
Thoughts, including all of their notes, properties, events, and attachments, can 
be copied and pasted between Brains or duplicated within a Brain. When 
Thoughts are copied, associated Thought types and link types are automatically 
copied as well. 

To copy a Thought within the same Brain: 

1. Right-click the Thought to be copied and then click the Copy Thought 
command on the context menu. 
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2. Activate the Thought that will be the parent of the newly copied Thought. 

3. Right-click within any blank area of the Brain and click Paste Thoughts on 
the context menu.  

 
4. The copied Thought will automatically be linked as a child of the active 

Thought and it will also retain all of its original relationships. 

 
Figure 61. Copied Thought 
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To create a duplicate of a Thought: 

If you just want to make a duplicate of a single Thought without retaining any of 
its links, the Create Duplicate Child Thought command is convenient. 

1. Right-click the Thought to be duplicated and then click the Create 
Duplicate Child Thought command on the context menu. 

2. The duplicated Thought will appear as a child of the original, as shown in 
the figure below.  

 
Figure 62. Duplicating a Thought Within a Brain 

To copy a Thought to another Brain: 

1. Right-click the Thought to be copied and then click the Copy Thought 
command on the context menu (or activate the Thought, click the Edit 
menu, and then click the Copy Thought command). 

2. Open the Brain into which you want to copy the Thought. 

3. Right-click on the background of the Plex and then click the Paste 
Thoughts command on the context menu (or click the Edit menu and then 
click the Paste Thoughts command). 
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4. The Thought will be pasted into the Brain and linked as a child of the active 
Thought. It will include any attachments, Thought Types, Notes, or other 
attributes it had in the original Brain. 

 

If you have selected multiple Thoughts, they can all be copied at once using the 
same technique. Right-click anyplace within the Selection box to open the 
context menu. See “Selecting Mulitple Thoughts” beginning on page 64 for 
complete instructions about selecting multiple Thoughts. 

Undoing and Redoing Actions 
Changing your mind about your actions is easy. You can undo up to 100 actions 
during your current session. Actions that have been undone can also be re-
executed using the Redo command. 

 
Figure 63. Undo and Redo Commands 

To undo an action: 
1. Click the Edit menu and then click the Undo command. The list on the 

secondary menu displays your most recent action first. 

2. To undo your most recent action, click the first item in the secondary menu. 
To undo multiple actions, select the oldest action to be undone from the list. 
All actions above that action will also be undone. 

To redo an action you have undone: 
1. Click the Edit menu and then click the Redo command. If there are multiple 

items that can be redone, a secondary menu will be displayed.  

2. Click the action of your choice. As in the list of actions that can be undone, 
the list is in most-recent-action-first order. All actions above the item you 
click will also be undone. 

 Once you close your Brain, the Undo and Redo lists are cleared. 
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Editing Thoughts and Links 

Renaming Thoughts 

There are three simple ways to rename an existing Thought: 

 Right-click the Thought to be renamed, and click Rename in the context 
menu, or  

 
Figure 64. Renaming a Thought Using the Context Menu 

 Highlight the Thought using the mouse pointer and press the F2 key, or 
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 Activate the Thought, then revise the name in the Properties & Attachments 
tab 

 
Figure 65. Renaming a Thought in the Properties & Attachments Tab 

Deleting and Forgetting Thoughts 
When you no longer need a Thought, it can be forgotten or deleted. A forgotten 
Thought may be remembered and restored later, or deleted. A deleted Thought 
is gone forever. This works very much like the Windows Recycle Bin/Trash 
feature on your desktop which stores your deleted files until you choose to 
remove them permanently. 

To forget a Thought: 

 Right-click the Thought to be deleted, then click Forget in the context menu. 

Once a Thought has been forgotten it will disappear from the display. If you want 
to access it again later temporarily, you can do so by turning on the display of 
forgotten Thoughts. You can also permanently delete forgotten Thoughts or you 
can remember them. 

To access forgotten Thoughts: 

1. Click the Options menu, then click the Forgotten Thoughts command. 
The Forgotten Thoughts dialog box will be displayed and your forgotten 
Thoughts will appear grayed out in the Plex. 
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Figure 66. Forgotten Thoughts Dialog Box 

2. You can click on the Thoughts in the dialog box to activate them. You can 
use forgotten Thoughts just like normal Thoughts as long as they are 
displayed. 

To delete all forgotten Thoughts using the Forgotten Thoughts dialog box: 

 Click the Select All button, then click the Delete button. You will be prompted 
to confirm the deletion. Alternately, you can use the Ctrl key to select multiple 
individual forgotten Thoughts and then delete only those. 

 

Closing the Forgotten Thoughts dialog box hides the forgotten Thoughts. You 
can also reinstate forgotten Thoughts by selecting them, then clicking the 
Remember button. Click the Refresh button to update the list, this may be 
necessary if you rename some Thoughts or forget, remember, or delete some 
Thoughts.  

It is generally recommended to forget Thoughts when you don’t need them so 
that you can easily retrieve them if you change your mind. If you are sure you will 
never need a Thought again and you do not want to be able to remember it in the 
future, you can delete it immediately without forgetting it first. 

To delete a Thought instantly: 

1. Hold down the Shift key as you right-click the Thought to be deleted. The 
context menu will be displayed, showing the Delete command in place of 
the Forget command. 
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Figure 67. Shift-Right-Click Context Menu for a Thought 

2. Click the Delete command, then click the OK button in the confirmation 
dialog box that displays. The Thought will be permanently deleted. Any 
internal attachment that may have been linked to this Thought will be 
moved to the computer’s recycle bin. 

To forget or delete multiple Thoughts: 
1. Hold down the Ctrl key as you click each Thought. 

2. Right-click in the Selection box, then click the Forget Selection command 
on the context menu. Hold down the Shift key while opening the menu to 
display the Delete Selection command instead. 

 
Figure 68. Selection Box Context Menu 

PersonalBrain User Guide 63 



 Editing Thoughts and Links  

Selecting Multiple Thoughts 
You can select multiple Thoughts and then apply actions—link, unlink, delete, set 
Thought type, and other actions you would apply to an individual Thought—to the 
selected Thoughts en masse. When multiple Thoughts are selected they are 
listed in a selection box on the left side of the Plex and they are highlighted in the 
Plex itself.  

 
Figure 69. Selection Box and Selected Thoughts 

 Throughout this section, wherever you see “Ctrl key,” use the Command key. 

To select Thoughts:  

 Hold down the Ctrl key as you click a Thought. 

 Hold down the Ctrl key as you click a gate to select all the Thoughts 
connected to that gate. 

To de-select Thoughts: 

 Click the close button at the top right of the selection box to de-select all 
selected Thoughts. 

 Hold down the Ctrl key as you click a Thought (either in the Plex or in the 
selection box) to de-select just that Thought. 

To perform actions on selected Thoughts: 

 Right-click in the selection box and select the action of your choice on the 
context menu. The entries in this menu are also displayed in the Edit menu. 
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Figure 70. Selection Box Context Menu 

Advanced Selection 
If you have a section of your Brain that you want to modify but you don’t want to 
select each Thought from the Plex, you can use the following techniques to 
quickly build a large selection. 

 Click the Edit menu, then click the Crawl Brain and Modify Selection 
command to select sets of connected Thoughts. You can choose what 
types of connections to follow to build the selection. 

 

With Crawl Brain selected you can add to the selection box from any direction 
around the Active Thought. Childward will be the Thoughts below, Parentward 
will be the Thoughts above, and Jumpward are Thoughts to the left of the active 
Thought. We recommend going to the top Thought of the area you want, and 
selecting Childward, as this is usually the easiest way to select a big group of 
Thoughts. 
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Figure 71. Crawl Brain and Modify Selection Dialog Box 

 You can also use the Edit menu to add the results from the Search tab or 
the Reports tab to the selection. 

Other Selection Uses 
Once you have created a selection, you can also use it for other things besides 
what you see in the menu: 

 Searches can be limited to the content of the selection 

 Exporting Thoughts from your Brain can be limited to the selection 

Unlinking Thoughts 

To unlink a Thought: 

 Click the link, the click the Unlink command on the context menu 

 Tip: If you are moving a Thought from one place to another by linking and 
unlinking it, it is generally easier to do the unlinking after you have done the 
linking. This avoids making the Thought into an “orphan,” a Thought with no 
relatives. 

If you have difficulty telling which link you are pointing at with the mouse, just 
look at the highlighted Thoughts. When the mouse pointer is over a link, it is 
highlighted along with the two Thoughts it connects. This makes it easy to tell 
which Thoughts will be unlinked if you click on the link. 
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In addition to being able to unlink Thoughts one link at a time, you can also use 
the multiple Thought selection function to unlink several Thoughts at once. To do 
so: 

 Select the Thoughts you want to unlink by holding down the Ctrl key and 
clicking on each one 

 Activate the Thought from which you wish to unlink the selected Thoughts 

 Right-click in the selection box and select the Unlink command  

Linking Existing Thoughts 
As noted previously, links are power. Not only do links allow for associations that 
group Thoughts conceptually, they allow information to be stored in and 
accessible from numerous places. 

 

A single Thought may have relationships with multiple Thoughts. For example, 
you may want a Thought named “Aunt Mary” to be a child of your “Mentors” 
Thought and also a child of your “Family” Thought. If your Aunt Mary is also 
helping you plan your next vacation, her Thought may also be a child or jump 
Thought to your “Vacation” Thought. The possibilities are endless. 

There are several ways to link to existing Thoughts, as described in the following 
sections. 

Link to Thoughts Visible in the Plex 
When the Thoughts you want to link are both visible in the Plex, you can simply 
drag from the desired gate of one Thought in the Plex to another Thought in the 
Plex. Note that the Thought you drag from does not have to be the Active 
Thought. 

In the Normal view, the display of Thoughts is limited to close relations. You may 
find it useful to use the Expanded view when linking Thoughts, because you can 
see more Thoughts at once. 

Link to Thoughts Not Visible in the Plex 
If both Thoughts are not displayed in the Plex they can still be easily linked in any 
of four ways. If the Thought you can’t see in the Plex has a pin or a name in the 
Past Thought List, you can drag links to them, or you can link by using the 
Existing Thoughts list in the Create Child dialog box to quickly find the Thought to 
which you want to link. Finally, you can also link using the selection. 

Link by Dragging to a Pin 
You can Link to a Thought that is not visible in the Plex if it has a pin. Simply 
drag from the appropriate gate to the pin (see Figure 72). Pins help you save 
time. When you want to link a Thought to many other Thoughts, create a pin of 
the Thought and link to it. 
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Figure 72. Dragging to a Pin 

Although pins do not normally have gates displayed, when they are highlighted 
with the mouse pointer, gates appear and can be used to create links.  

The relationship you establish by linking a Thought to a pin is between the 
Thoughts; if you delete the pin, the Link between the Thoughts will remain. 

Link by Dragging to the Past Thought List 
As with pins, you can link a Thought in the Plex to other Thoughts by dragging a 
Link from the appropriate gate of the Thought in the Plex to a Thought in the past 
Thought list (see Figure 73). Like pins, Thoughts in the Past Thought List do not 
have gates displayed normally, but when they are highlighted with the mouse 
pointer, gates appear and can be used to create links.  

 
Figure 73. Dragging to the Past Thought List 
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Link by Selecting a Thought in the Create Child Dialog Box 
You can also link by using the Create Thought dialog box: 

1. Start creating a Thought by dragging or using the Thought menu. The 
Create Thought dialog box appears.  

2. Type the first few letters of the name of the Thought you want to link to. 
PersonalBrain will fill in the rest (see Figure 74). 

3. Select the Thought and click the checkmark.  

 
Figure 74. Use the Create Child Dialog Box to Link 

Link Using the Selection 
Thoughts in the selection can be linked to the active Thought using the Selection 
menu: 

1. Select the Thought or Thoughts you want to link using Ctrl-click. 

2. Activate the Thought to which you want to link. 

3. Right-click the Selection box, then click the link command of your choice in 
the context menu. 
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Figure 75. Linking Using the Selection 

Changing Relationships Using Drag and Drop 

Say that you decide that your “Marketing” Thought shouldn’t really be a child of 
your “My Clients” Thought. Instead, it should be the child of “My Web Services.” 
You can quickly change relationships between Thoughts in a single step: Hold 
down the Shift key while linking a Thought to a new parent. All of the current 
parents will be unlinked automatically. Note that even if a Thought has more than 
one parent, all of the former parents will be unlinked.  

 
Figure 76. Changing Relationships 
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Thought and Link Properties 

Changing the Appearance of a Thought  

Thought Drop Shadows and Backgrounds 
You can add drop shadows globally to all Thought names so they can be seen 
more prominently. You can also turn on and off the display of backgrounds 
behind Thought names. The colors of both shadows and backgrounds can be 
customized as described below. 

 
Figure 77. Text Shadows (Before and After) 

To toggle the display of shadows and backgrounds:  

1. Open the Preferences dialog box by selecting Preferences on the 
Options menu or the Plex context menu. 

2. Click the Look & Feel icon at the top of the box.  

3. Check or uncheck boxes next to Text shadows and Backgrounds as 
appropriate, then click OK. 

To change the colors of shadows and backgrounds: 

1. Open the Preferences dialog box by selecting Preferences on the 
Options menu or the Plex context menu. 

2. Click the Colors icon at the top of the box.  

3. Click either the item you want to change (Thoughts, text shadow or 
Thoughts, background). The color selection dialog box will be displayed: 
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Figure 78. Colors Section of Preferences Dialog Box 

4. Click the color of your choice, then click the OK button.  

5. Click the OK button in the Preferences dialog box. 

Changing the Size of Thought Text 
You can change the size of your Thoughts by using the mouse wheel. Sliding the 
wheel up (away from you) while hovering the mouse over the active Thought 
makes all Thoughts larger; sliding it down (towards you) makes all Thoughts 
smaller. You can also change the size of all Thoughts by dragging the resizing 
circle that appears behind the active Thought. 
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Figure 79. Changing Size of Thought Text 

Changing a Thought’s Text Color 
You can assign a specific color to a Thought so that it stands out visually. To 
assign a color to a Thought:  

1. Activate the Thought and click the Properties & Attachments tab. Or, 
right-click the Thought you want to change and select Properties & 
Attachments on the context menu. 

2. Click the Display button, then click the Set Color command. The Select 
Thought Color dialog box will be displayed. 

 
Figure 80. Select Thought Color for Active Thought 
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3. Click the color of your choice, then click the OK button. 

4. If you used the right-click method to open the properties window, close it 
when you are through making changes. 

Adding a Label to a Thought 
Labels are hints that appear below Thoughts when the mouse cursor is placed 
over them. 

 
Figure 81. A Thought label 

To add a label to a Thought: 

1. Activate the Thought and click the Properties & Attachments tab or right-
click the Thought you want to change and select Properties & 
Attachments on the context menu. 

2. Type the text for the label in the Label field. When you point at the Thought, 
the label text will appear in a box below the Thought. 

 
Figure 82. Label Field in Properties & Attachments 

3. If you used the right-click method to open the Properties window, close it 
when you are through making changes. 

Attaching Images to Thoughts 
You can attach pictures to your Thoughts to provide a visual boost to your Brain. 
When you point to the icon next to the Thought, the picture zooms to a larger 
size automatically.  
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Figure 83. A Thought Icon 

To add an image icon to a Thought: 

1. Copy the image you want to use into the clipboard. For example, if the 
image is on a Web page, open the page in your browser, right-click the 
picture, then click the Copy command on the context menu. If the image 
isn’t on a Web page, right-click it from within any document, then click the 
Copy command on the context menu. 

2. Right-click the Thought, then click the Paste Thought Icon command on 
the context menu. 

 
Figure 84. Paste Thought Icon Command 
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To change a Thought’s icon, follow the steps above and click the OK button in 
the Overwrite existing image? dialog box.  

 
Figure 85. Overwrite Existing Image Confirmation Box 

You can use this feature to add instant previews of documents and Web pages 
you have added to a Thought. Just open the item you want to preview, take a 
screenshot (in Windows, press Alt+Print Screen to capture just the active 
Window) and use the Paste Thought Icon command. 

To remove a Thought’s icon: 

1. Activate the Thought that has the icon to be removed. 

2. Click the Properties & Attachments tab. The properties for the active 
Thought will be displayed. 

 
Figure 86. Removing a Thought Icon 

3. Click the Display button, then click the Remove Icon command. 

 Images that you have attached to Thoughts are automatically loaded as 
thumbnails. When you point to the image, the picture zooms to a larger size 
automatically. Supported file formats for images include .jpg, png, and .gif. 

Thoughts Types 

If you have several Thoughts with which you want to share common attributes, 
such as color and an icon, you may want to create a Thought type so that these 
attributes can be easily applied to many Thoughts. This is one use of Thought 
types. 
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For example, you may want to create a “person” type for all Thoughts that 
represent people in your Brain. This type might have a label— “Person”—and a 
specific color and icon so that all people in your Brain stand out and can be 
easily recognized. 

 
Figure 87. Three “Person” Type Thoughts 

Once a type has been applied to a set of Thoughts, it can also be used to filter 
searches in your Brain and to create reports of all Thoughts of that type. 

When a type has been assigned to a Thought, that Thought is said to be an 
“instance” of the type. For example, if you have a Thought named “Jane” of the 
“Person” type, the Jane Thought is said to be an instance of the Person type. 

Creating a Thought Type 
To create a Thought type: 

1. Activate the Thought you want to be the first instance of the new type. 

2. Click the Properties & Attachments tab, click the Type button, then click 
the New Type command. 

3. Enter the name of the type you want to create. 

4. A dialog box for the type will appear. The label for the type will 
automatically be set to match the name of the type. 

5. Customize the attributes of the type the same way you edit the attributes of 
a Thought. You can set a color, icon, and a label. The attributes will be 
automatically applied to the instances of the type. 

Assigning a Thought Type 
When you create a Thought type, it is automatically assigned to the Thought that 
you created it from. If you want to assign an existing Thought type to a Thought, 
just select it from the drop list on the Properties & Attachments tab for the 
Thought.  
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Figure 88. Drop-down List for Selecting a Thought Type 

Alternately, you can right-click the Thought, click Thought Type on the context 
menu, then click the type of your choice to assign it to that Thought. 

 Tip: To arrange your display by Thought types, right-click on the Plex 
background, click Arrange Thoughts by, then click Type. 

 

Attributes that are assigned to a Thought type are inherited by all instances of 
the Type but will be overridden if there are attributes assigned directly to the 
Thought itself. For example, if you have a Thought named “Jane” of the type 
“Person,” you can assign an icon of a smiley face to the Person type and it will 
appear next the Jane Thought and all other instances of the Person type. But, if 
you then assign a picture of Jane as the icon for that Thought, the picture will 
appear on that Thought (only) instead of the smiley face. Likewise, a label 
assigned to a specific Thought would override the label of any Thought type 
assigned to that Thought. 

Editing a Thought Type 
To edit a Thought type: 

1. Activate a Thought of the type you want to edit. 

2. Click the Properties & Attachments tab, click the Type button and click 
the Edit Type command. 

3. A dialog box for the type will appear. Use this dialog box to modify the type. 

Deleting a Thought Type 
To delete a Thought type: 

1. Activate a Thought of the type you want to delete. 

2. Click the Properties & Attachments tab, click the Type button, then click 
the Delete Type command. All Thoughts of that type will be changed to 
“untyped” Thoughts. 
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Super Types 
PersonalBrain supports multiple levels of types for advanced modeling. Just like 
a Thought can have a type, each type may in turn have a super type. Super 
types are set on the dialog box for the type in the same way a type is set in a 
Thought’s Properties & Attachments dialog box. The attributes assigned to a 
super type are inherited by its sub types and instances.  

Super types can be used when there is a category of Thoughts which is subset of 
a larger category. For example, the Thought type “Person” could be the super 
type of the type “Executive.”  

 

If there are multiple attributes you would like to add to your Thoughts, you can 
create Thought tags. For information about creating and using tags, please see 
the Tags section beginning on page 128. 

Making Thoughts Private 
Thoughts may be marked “Private.” Private Thoughts will appear in a different 
color (based on the Preference settings for Thought colors). When you export 
your Brain, you have an opportunity to include or exclude private Thoughts. 
Select the Private check box in the Thought’s Properties & Attachments tab to 
mark the Thought as private.  

 
Figure 89. A Private Thought 

Changing the Appearance of a Link 
Links are created automatically when you create Thoughts. You can control the 
way they appear in order to clarify relationships or just to create a more pleasing 
view of your Brain, based on your personal preference. You can also manipulate 
links in order to add or change relationships between your Thoughts. 

To change the appearance of a link: 

1. Click the link whose properties you want to change.  
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2. Click Link Properties on the context menu. The properties for the link will 
be displayed:  

 
Figure 90. Options for Changing Link Properties 

 To display a label for the link, type the text in the Label field. 

 To change the link’s color, click the Set Color button, click the color of 
your choice, then click the OK button. 

 To change the width of the line used for the link, select from the drop-
down list for Thickness. 

3. Close the dialog box when you are through making changes. 

 
You might want to thicken links to illustrate the strength of particular relationships 
between Thoughts. 

Link Types 

Link types are used to assign commonly-used relationships between Thoughts 
that share a label, color, and thickness so they can be easily recognized. Link 
properties and types will be retained even if the two linked Thoughts change their 
relationship but remain linked (for example, if a child Thought becomes a jump 
Thought of the original Thought). 

 In addition to setting their color, you can add labels to link types and you can 
change the thickness of the link to call special attention to relationships. 

1. Click the link for which you want to create a type, then click the Link 
Properties command on the context menu.  
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Figure 91. Link Properties Command on Link Context Menu 

2. Click the New… button in the dialog box and enter the name for the link 
type you want to create. 

3. Whatever is typed in the Label field will automatically display when you 
point to the link in the Plex. Changing the Label text will also automatically 
change the name of the link type. 

 
Figure 92. Link Properties Dialog Box 

4. To change the thickness of the link, click the drop-down list button for the 
Thickness field, then click the thickness of your choice. 

5. Click the Set Color button if you want to change the color of the link type. 

6. Close the dialog box when you are done. The new link type you created will 
now appear in the Link Type submenu whenever a link is clicked. 
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To change the appearance of a link type: 

 Click the link that is attached to the type you want to revise, click the Link 
Properties command on the context menu, then make the edits  

To delete a link type: 

 Click the link that is attached to the type you want to delete, click the Link 
Properties command on the context menu, click the Delete… button, then 
click Yes to confirm the deletion 
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Adding Files, Web Pages, and Folders 

You can add any number of files, Web pages, and folders to your Brain. There 
are many ways to do this as covered in this section, but in general, the simplest 
way to integrate all of these items is to simply drag and drop them into the Plex. 

Attachments are displayed in the attachment list at the bottom of the Properties 
& Attachments tab. An attachment may have the same name as its Thought, 
but it doesn’t have to—attachments can be renamed easily. 

You can view the attachment list for non-active Thoughts by right clicking on 
them and then clicking Properties & Attachments on the context menu. 

 

All of the information in your Brain is contained in the .brain file and _brain folder. 
Internal attachments are stored in the “Files” subfolder of that folder. For 
example, if you’ve named a Brain “Market Research,” any Thought attachments 
will be stored within a folder named “Market Research_brain\Files.” The Files 
folder contains subfolders for each Thought with attachments that organize 
content stored in your Brain. The Thought folder is also used to store Thought 
icons and images inserted into Thought Notes. 

Opening and Renaming Attachments  

There are many ways to open an attachment. 

To open an attachment directly from the Plex: 

 Click on the icon next to the Thought with which the attachment is associated. 
If there are multiple attachments, a list will be displayed for you to use to 
choose which attachment you want to open. If there is only one attachment, it 
will be opened immediately. 

Use any of these methods to open an attachment from the attachment list: 

 Double-click the attachment, or 

 Click the attachment, then click the Open the selected attachments button 
on the toolbar located above the attachment list, or 

 Right-click the attachment, then click the Open command on the context 
menu 

To rename an attachment: 

1. Activate the Thought that contains the attachment to be renamed. 

2. Click the Properties & Attachments tab. 
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3. Click the attachment’s name so it is selected, pause, and then click it a 
second time to indicate that you want to rename it or right-click the 
attachment in the list, then click the Rename command in the context 
menu. 

 Tip: You can also rename a selected attachment by pressing the F2 key and 
then making your changes.  

The location of URL attachments may also be edited using the steps above 
except that you should click on the attachment’s location instead of its name. 

Drag and Drop 

“Drag and drop” techniques can be used to add information into your Brain from 
other programs as well as move information from your Brain into other programs. 

Adding Attachments Using Drag and Drop 
You can use standard “drag and drop” techniques to add attachments to a 
Thought or to create new Thoughts by dragging and dropping from: 

 Your Web Browser: For Windows, Firefox and Internet Explorer are both 
supported. For Mac OS X, Firefox, Safari, and Camino are supported. Other 
browsers that support drag and drop of URLs will also work. 

   
Your File Manager: 

♦  The desktop and file Explorer can be used as a source for drag 
and drop operations. 

♦  The desktop and Finder can be used as a source for drag and 
drop operations. 

♦ Other applications that support drag and drop of files will also work. 

  Microsoft Outlook: 

♦ If you use Outlook for email, contacts, or other data, you can drag and 
drop many types of information into PersonalBrain and a link to the 
original item will be created.  
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When you drop an item in PersonalBrain, you may drop it in different locations to 
accomplish different results. For example: 

 Drop items on an empty area in the Plex to create new Thoughts: New 
child Thoughts will be created and named based on the items that were 
dropped. The Thoughts will be linked to the active Thought.  

 

 Drop items on any Thought visible in the Plex to attach them to that 
Thought: The dropped items will be attached to the Thought on which it was 
dropped. 

 

 Drop items on the attachment list: The dropped item will be added to the 
list. Note that items can be dropped both on the attachment list of the active 
Thought as well as any other attachment lists you may have opened via the 
right-click context menu. 

 When adding attachments, not only can you create links to them, but you can 
choose to move or copy some items into your Brain. Moving or copying files into 
your Brain makes it easy back up all the information in your Brain easily and also 
makes it easier to share this information since it is all in one place. 
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 Link attachment: Drag and drop defaults to creating a link to the item. The 
original version stays in its original location and the attachment is not moved 
or copied. Whenever you open a linked item, you are opening the originally 
dragged item. If the original item is moved or deleted, it will no longer be 
accessible from your Brain. 

 Copy attachment: Holding down the Ctrl key as you drop the item into your 
Brain makes a copy of that item and stores it internally, inside of your Brain. If 
you make revisions in the attachment in your Brain, the revisions will not be 
reflected in the original source file and if the original source file is moved or 
deleted, it will not affect the copy that is in your Brain. 

 Move attachment: Holding down the Ctrl and Shift keys as you drop an item 
into your Brain will move that item into your Brain, removing it from its original 
location. 

 

Only files can be copied or moved. Web pages are always attached as links. If 
you want to copy the content of a Web page into your Brain, either save it as a 
file or copy and paste its content into a Thought’s Notes. 

 
Figure 93. Dragging New Attachments 

Copying and Moving to Other Locations with Drag and Drop 
You can also use drag and drop on items in the attachments list to move or copy 
them to locations outside of your Brain. 

 Move the attachment: Dragging the item out of your Brain removes it from 
the brain and places it in the destination to which you drag.  

 Copy the attachment: Holding down the Ctrl key as you drag the item from 
your Brain places a copy in the destination and retains the original 
attachment in your Brain. 

 Tip: You can also drag and drop attachments from your Brain onto other 
programs that support drag and drop so that the other application will open the 
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file. For example, you can drag and drop a Web page from the attachment list to 
a browser window to have the browser open that page.  

Drag and drop can also be used to move and copy attachments between 
Thoughts—drag from the attachment list to the Plex or to another attachment list. 

Moving a File into a Brain After It Is Attached as a Shortcut to a 
Thought 
 Right-click the filename in the Properties & Attachments tab, then click the 

Move File into Brain command. The small arrow in the icon to the left of the 
Thought name will disappear once the file is moved into the Brain and the 
location will appear as “Internal.” 

 Tip: You can change the default for what happens when you drag and drop files 
into your Brain. In the UI section of the Preferences dialog box, select “Move 
dropped files” instead of “Link to dropped files” for the On drag and drop of files 
to PersonalBrain setting. This will move the file into your Brain instead of only 
creating a shortcut to it. 

Moving a File Out of PersonalBrain 
 To move a file out of PersonalBrain, drag the file out of the Properties & 

Attachments tab and drop it into the location of your choice.  

Copy and Paste 

 You can use standard copy and paste techniques to add items to the attachment 
list in the Thought’s Properties & Attachments tab. 

1. Activate the Thought in which you want to add the attachment and click the 
Properties & Attachments tab. 

2. Copy the attachment in the application of your choice (for example, if you 
want to add a file from your desktop, right-click the file’s icon). 

3. Right-click below any attachments in the list, then click the Paste 
Files/Folders command on the context menu. You can also click the Paste 
button in the toolbar at the top of the attachment list. You can also use the 
Thought menu to paste into the active Thought or you can right-click on any 
Thought and paste into it via the context menu. 
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Figure 94. Attachments Context Menu 

 Tip: The context menu displays a different set of commands based on where you 
click. Clicking below the list in an empty area will show fewer commands 
because those that are applicable to a specific attachment will not be displayed. 

Copying an Attachment from One Thought to Another 

 You can easily copy attachments between Thoughts using context menus. 

1. Activate the Thought containing the attachment you want to copy and click 
the Properties & Attachments tab. 

2. Right-click the attachment in the list, then click the Copy command on the 
context menu. 

3. Right-click the Thought to receive the copied attachment, then click the 
Paste Files/Folders command on the context menu. 

 Tip: If you prefer, instead of using the context menus, you can Ctrl-drag an 
attachment from the list to any Thought in the Plex to copy the attachment from 
one Thought to another.  

Using the Save As Command 

 You can use any application’s “Save as” command to create a new file inside 
your Brain. For example, if you have opened a Word file that is an internal 
attachment to a Thought, you would click the File menu, click the Save as 
command, then enter the name of the new file to create. The new file will 
automatically appear in the Thought’s attachment list. 
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Attachment List Context Menus 

 The attachment list in the Properties & Attachments tab makes it easy to view 
and change information quickly. Right-click an attachment to display all available 
commands. 

 
Figure 95. Attachments Shortcut Menu 

File Attachment Context Menu 
The file attachment context menu includes the following commands: 

 Open: Open the selected attachment in its default application 

 Open with …: Open the selected attachment in an application that you will 
specify 

 Copy to Templates: Create a template that you can use to create new 
attachments based on the selected attachment 

 Move File out of/into Brain: Switch this attachment between internal and 
external storage; if you are moving the file out of your Brain, you will be 
prompted to specify the destination folder 

 Copy: Copy the selected attachment to the clipboard 

 Cut: Place the selected attachment into the clipboard; the attachment will be 
removed from its current location when it is pasted elsewhere in your Brain  
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 Paste Files/Folders: Paste a file or folder you have previously copied (this 
command is only visible if there is a file or folder in the clipboard) 

 Delete: Delete the selected attachment (you will be prompted to confirm the 
deletion) 

 Rename: Change the name of the selected attachment 

   Email Attachment Using Outlook: Open Outlook (unless 
it is already open), start a new message, and automatically add the selected 
attachment as an attachment of the new message 

 Add Attachment: Create a new attachment  

 Open Thought Folder: Open the folder where attachments for the Thought 
are stored. 

URL Attachment Context Menu 
An attachment that is a Web address has a slightly different context menu. 

 When you right-click an attachment that is a Web address and select the Email 
URL command, a new message will be started in Outlook and the address will be 
inserted into the message text area. 

 
Figure 96. URL Shortcut Menu 
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Attachment List Settings 

 You can sort the list of attachments by their name, date, size, type, or location. 
To do so, simply click the heading of the column by which you want to see the list 
sorted. To reverse the sort order, click the heading again. The current sort order 
is indicated by the small arrow displayed in the heading. 

The order of the columns in the attachment list and their sizes can also be 
adjusted. To change the location of the columns, just drag the column heading to 
the location of your choice. To change the size of a column, drag the border of 
the column header. 

 
Figure 97. Attachment List 

Working with Multiple Attachments 

 You can add multiple attachments to Thoughts and you can have many types of 
attachments for a single Thought. For example, if you have a Thought for a 
person, you might attach their blog as a Web page, their resume in a file, and 
their contact information as an Outlook link—all in the same Thought. 

When there is more than one attachment, the number of attachments is 
displayed on the Thought icon. For example, the Thought shown below has two 
attachments: 

 
Figure 98. Number of Attachments Indicator 
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To add a new attachment: 

1. Activate the Thought to which you want to add an attachment. 

2. Use any of these four methods to begin adding an attachment: 

 Click the Thought menu, then click the Add Attachment command. 

 Right-click the Thought, then click the Add Attachment command. 

 Click the Properties & Attachments tab, then click the Add 
Attachment button or double-click in an empty area of the attachment 
list. 

 Drag and drop an item into the attachment list. 

 
Figure 99. Adding Additional Attachments 
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 If you selected the Add Attachment command, the following dialog box will 
be displayed: 

 
Figure 100. Add Attachment Dialog Box 

 To create a new file, click the type of file you wish to create from the 
list. You can add files to use as templates by clicking the 
Templates… button.  

 
 New file types will appear on this list automatically when you install 

new software on your computer. 

 To select an existing file, click the Link to File button, navigate to the 
file of your choice, then click the Open button. 

 To select an existing folder, click the Link to Folder button, navigate 
to the folder of your choice, then click the OK button.  

 To select a Web address, click the Link to URL button, type or paste 
in the Internet address, then click the OK button.  

Creating Virtual Thoughts by Dragging and Dropping Folders 

 Virtual Thoughts are used to represent folders that connect to your Brain but are 
not stored inside your Brain. They are created automatically when you drag a 
folder into the Plex. 

Files within virtual Thoughts do not appear in the Plex as child Thoughts; they 
appear in the Properties & Attachments tab. If a virtual Thought contains 
folders, the folders will appear in the Plex as child Thoughts. 

In addition to allowing you to navigate through the folders, Virtual Thoughts also 
have the following capabilities:  

 You can enter Notes (including images) for virtual Thoughts.  
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 You can create, delete, rename, copy and move files within virtual Thought 
folders just as you would with regular Thoughts. 

 You can create Thoughts from virtual Thoughts and link Virtual Thoughts to 
other Thoughts. 

 
Figure 101. A Virtual Thought Represented by a Folder 

 

When you open and save files that are in virtual Thoughts, they remain in their 
original locations and are not converted into internal files. Any changes you make 
to the contents of the folder that a virtual Thought represents are reflected 
automatically in PersonalBrain. 

 
Figure 102. Files Inside of a Virtual Thought Folder 

 
“Show virtual Thoughts for folders” must be selected in the UI section of the 
Preferences dialog box in order for the files to show. 
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To remove a virtual Thought from your Brain: 

 Click the link of the virtual Thought 

 Click the Unlink command 

 
Figure 103. Deleting a Virtual Thought 

Adding a Template File to Your Brain 
There may be types of files that you create frequently that share a common look 
and feel. For example, you may prepare correspondence using a common 
letterhead. You can designate template files that will be at your fingertips 
whenever you create attachments. 

To create a template file: 

1. Click the Add Attachment button in the Properties & Attachments tab. 

2. Click the Templates button. 

 
Figure 104. Adding a New Template 

3. Click the Yes button to confirm that you want to open the templates folder. 
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4. Click the Yes button to confirm that you want to open the templates folder. 

5. Drag the file of your choice into the window, then close the window. If your 
file is on the desktop, you can drag it from there; otherwise, use your file 
manager to navigate to the file of your choice. 

 The next time you open the Add Attachment dialog box, the file you added 
will be available in the list of attachments.  

 Tip: If you edit one of the files in your templates folder, save it under a new name 
in order to preserve your original template. 
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Advanced Navigation and Alternate Views 

Changing How You View Your Thoughts 

 There are three views for displaying your Thoughts: 

 Normal view: For focusing on the active Thought and displaying information 
pertaining to it―parent Thoughts above, child Thoughts below, and jump 
Thoughts to the left. In Normal view, you can expand the generations of 
Thoughts you see by clicking the Expand All button. Clicking the Collapse 
All button restores the view to the previous number of generations. 

 
Figure 105. Viewing or Hiding Distant Thoughts in Normal View 

 Outline view: For a more expanded, primarily hierarchical view of your 
Thoughts. 

 Expanded view: For displaying a limitless number of generations at once. 

There are three ways to change to a different view—use the Switch View button, 
use the View menu, or use the context menu. 

To use the Switch View button to change the view: 

 Click the Switch View button at the top of the screen (just below the menu 
bar), then click the view of your choice.  

 
Figure 106. Switch Views Button 
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To use the View menu or context menu to change the view: 

 Click the View menu or right-click in the Plex background, click the View 
command, then click the view of your choice.  

To use the context menu to change the view: 

 Right-click in the Plex, click the View command, then click the view of your 
choice.  

 
Figure 107. Menus for Switching Views 

 Tip: One way of quickly identifying the current view is to note which view has the 
check mark. 

 

A rule of thumb for when you might use each view is to use Normal view when 
you’re creating Thoughts and navigating the Plex, use Outline view when you 
want to see a more traditional structure, and to use Expanded view for viewing 
and analyzing Thoughts. 
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Using Outline View 

 
Figure 108. Plex in Outline View 

Providing a clean, organized way of looking at your Thoughts, Outline view 
enables a fast, easily understood overview of the active area of your Thought 
network. The level of detail can go as deep as you want while maintaining an 
ordered view.  

The Expand All and Collapse All commands on the View menu and the 
PersonalBrain button bar let you show and hide entire levels of the display at 
once.  

 
Figure 109. Expanding or Collapsing from the View Menu 
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You can expand or collapse Thoughts one level at a time or on a case-by-case 
basis by clicking the Collapse or Expand buttons that appear when you point at a 
Thought. This gives you everything from fine-grained control to the power of 
seeing large amounts of information in just a few clicks. 

 
Figure 110. Collapse or Expand a Thought 

Much like a conventional outline, in this view, parent Thoughts appear to the 
upper-left and child Thoughts appear to the lower-right of the active Thought. In 
addition, each child’s children appear indented below them when they are 
expanded. In contrast to a standard outline, however, jump Thoughts are also 
displayed. They appear to the lower-left of the active Thought. This view also 
differs from normal outlines in that network relationships are represented by 
additional links that appear between Thoughts. For example, if a Thought is both 
the child of the active Thought as well as a child of one of the active Thought’s 
parents, this will be shown by a line connecting the two. When hovering the 
mouse pointer over these lines the related Thoughts are highlighted. 

Using Expanded Thoughts View 

 Using the Expanded Thoughts view along with the Expand All 
command lets you see all generations of your Thoughts. Using the Expanded 
view gives you ultimate flexibility and control over which Thoughts are displayed 
and how they are arranged. Not only can you expand your view in every direction 
at once, but you can even choose to expand or collapse some Thoughts while 
leaving others as they are. You can also save expanded views for easy access 
later. 
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Figure 111. Jane’s Brain in Normal View 

 
Figure 112. Jane’s Brain in Expanded View after Expanding All 
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Figure 113. 5 Generations of Thoughts 

A border around a Thought indicates that all of its generations are currently 
showing. 

When you switch to Expanded Thoughts view, additional generations do not 
initially display. Click the Expand All and Collapse All buttons on the toolbar to 
show and hide distant Thoughts. You can also use the Expand All and Collapse 
All commands on the Options menu or the context menu (as shown in Figure 
107). 

 
Figure 114. Expand All and Collapse All Buttons Increase/Decrease Generations 
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Expanding All Thoughts by One Generation 
When your Brain is in Expanded view you can expand all visible Thoughts by one 
generation by clicking the Expand All button. Each time you click this button, 
another generation of all Thoughts will appear in the Plex. 

 
Figure 115. Expand All Button 

Collapsing All Thoughts 
When your Brain is in Expanded view you can collapse all Thoughts by clicking 
the Collapse All button. Only the active Thought will remain in the Plex. 

 
Figure 116. Collapse All Button 

 
When your Brain is in Normal view, clicking the Collapse All button hides one 
generation of Thoughts (the youngest). 
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Expanding and Collapsing Individual Thoughts 
When your Brain is in Expanded view you can expand or collapse one or more 
Thoughts by using controls that appear when you point at a Thought with the 
mouse. You can expand an individual Thought up to two generations using these 
controls. 

 
Figure 117. Expand and Collapse Thought Controls  

The Thought will remain as you left it (expanded, collapsed, or however it was 
previously) even when you point at a different Thought and expand or collapse it. 

Thoughts that are surrounded by a dotted-line border have already been fully 
expanded. 

 
Figure 118. Appearance of Expanded Thoughts 

Panning and Scaling the Expanded View 
When in Expanded view, Thoughts may be displayed anywhere within the Plex 
window; the network of Thoughts may be too large to display all Thoughts 
onscreen at once.  

To move all of the Thoughts onscreen at once, use your mouse to drag any blank 
area of the Plex window. You can drag up, down, left, or right to position the 
Thoughts in the Plex as you want to see them. Your Brain will retain its current 
structure as you reposition it within the Plex. 

To see more of the view at once, you can resize Thoughts using the mouse 
wheel or by dragging the resizing circle behind the active Thought. 

 Tip: When you use Expanded view, you may find it more convenient to switch 
the Plex to full screen. Double-click within the Plex to maximize it. Double-click a 
second time to restore the Tools tabs. 

Adjusting the Distance Between Thoughts 
When your Brain is in Expanded view you can change the distance between 
Thoughts by holding down the Ctrl key as you move the mouse wheel up or 
down. 
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 Ctrl-wheel up to increase the distance between Thoughts 

 Ctrl-wheel down to decrease the distance between Thoughts 

Dragging Thoughts to Different Locations in the Plex 
When your Brain is in Expanded view you can adjust the layout of Thoughts by 
dragging them to a new location in the Plex. Dragging a Thought will 
automatically pull along connected Thoughts and push other Thoughts out of the 
way as you drag.  

Thoughts that have been dragged will be anchored to their assigned location 
unless you move them again, you change the view, or unanchor them using the 
Anchor control described below. 

Before you drag a Thought, the circle in its Anchor control will be empty. After 
you drag a Thought, the circle in its Anchor control will be filled. When the 
control is filled, the Thought will not move unless you move it yourself. When the 
Anchor control is empty, the Thought will automatically be repositioned based on 
the location of the connected Thoughts. 

You can click the Anchor control to toggle its state. 

 
Figure 119. The Anchor Control 

 
Figure 120. A Thought Dragged and Anchored 
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Saving Expanded Views 
Now you can save and recall customized Thought layouts just how you left them. 
Saved expanded views are also included in BrainZips. 

 
Figure 121. Options for Saving and Managing Expanded Views 

To save an expanded view: 

1. Enter the expanded view and arrange the Thoughts as you prefer, including 
activating the Thought you want to be active when you display the view. 

2. Click the View menu. 

3. Click the Save Expanded View command. 

4. Type a name for the view and then click OK. 

To load an expanded view: 

1. Click the View menu. 

2. Open the Load Expanded View submenu and click the view of your choice. 

Managing Saved Views 
After you’ve saved an expanded view, you’ll be able to give it a different name or 
delete it. It’s a good practice to delete views you believe you’ll never want to 
access again. 

To save the View under a new name: 

1. Click the View menu. 

2. Click the Save Expanded View As command, type in a new name, then click 
OK. 
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To rename a saved view: 

1. Click the View menu. 

2. Click the Manage Saved Views command 

3. Click the view to be renamed. 

4. Click the Rename button, make any revisions to the name, then click OK. 

5. Click the Close button. 

To delete a saved view: 

1. Click the View menu. 

2. Click the Manage Saved Views command 

3. Click the view to be deleted. 

4. Click the Delete button, then click OK to confirm. 

5. Click the Close button. 

 Tip: Use the mouse wheel to scroll through your Thoughts or adjust spacing, 
based on the active view: 

When the Plex is in … The mouse wheel … 

Normal view  Scrolls through the set of Thoughts where the 
mouse is pointing (children, parents, jumps or 
siblings) 

Expanded view Adjusts the spacing between Thoughts  

Outline view Scrolls through the entire display 

Scroll Bars 

When your Brain is in Normal view and there are more Thoughts linked to the 
active Thought than those currently showing in the Plex, you will see 
PersonalBrain’s vertical and/or horizontal scroll bars. You can drag the scroll box 
in the bar to view Thoughts that are off the screen. The size of the scroll box 
automatically adjusts to give you an approximate idea of how much content there 
is off-screen—a smaller scroll box means there is more off-screen data.  
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Figure 122. Appearance of Scroll Bars Indicates Off-screen Volume 

Filtering Thoughts from the View 
If you find that you have too many Thoughts onscreen that you are no longer 
using, but you do not want to forget them, you can specify Thoughts to be hidden 
based on how recently you activated them. By default, the unfiltered display 
shows all Thoughts regardless of how long it has been since you activated them. 
By turning on the filter, you can choose to hide Thoughts that you haven’t 
accessed within a specified number of days: 

1. Click the Options menu, then click the Filter Thoughts command (or click 
the Filter Thoughts button on the main toolbar). The Select Filter State 
dialog box will be displayed. 
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Figure 123. Select Filter State Dialog Box 

2. Click the Hide Thoughts not accessed within radio button. 

3. Replace the current number with your preferred number of days, then click 
the OK button. 

The current filter state is indicated in the toolbar by the Filter Thoughts button. 
When the button appears more dense, with a gray background, Thoughts are not 
currently being filtered. When there is a solid white background, a filter is active. 

 
Figure 124. Appearances of Filter Button 

The filter settings affect which Thoughts will display in the Plex, the search 
results, and reports. 

 Tip: Remember to check this setting if you can’t find something that you 
remember putting into your Brain. 
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Presenting Your Brain 
You can take advantage of all PersonalBrain’s powerful display options to wow 
your audience while enhancing their understanding. You can leverage the 
connections in your Brain to help you tailor a presentation according to the 
audience’s interest.  

 
Presentation mode takes over the entire screen and automatically hides the Past 
Thought list.  

Entering Presentation Mode 
 Right-click a blank area in the Plex, then click the Presentation Mode 

command. (Or, optionally, click the View menu, then click the Presentation 
Mode command.)  

Exiting Presentation Mode 
 Press the Esc key or right-click a blank area in the Plex, then click the 

Presentation Mode command to de-select it.  

Hiding Pins While Presenting 
If you like, you can prevent pins from showing when your Brain is in Presentation 
mode. 

1. Click the Options menu, then click the Preferences command. (Or, 
optionally, right-click a blank area in the Plex, then click Preferences.) 

2. Click the UI button at the top of the Preferences dialog box. 

3. Click the Hide pins in presentation mode check box.  

4. Click OK to save your setting. 
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Figure 125. Hiding Pins in Presentation Mode 

Using Your Brain’s Extra Sensory Perception (ESP) 

ESP Sync is a feature that works automatically to anticipate what Thought you 
might want to activate, based on what you’re doing in another application—typing 
text or copying text, files, or URLs. This intuitive assistance means you don’t 
need to navigate to the Thought yourself. Note that ESP only monitors what you 
type under Windows. 

 When ESP Sync suggests a Thought, the suggestion appears in large 
dimmed type below the activate Thought. 

 When ESP Sync activates a Thought, it is moved to the center of the Plex as 
if you activated it yourself. The name of the most recent active Thought 
appears in large dimmed type below the ESP Sync-activated Thought. 

 
Whether ESP Sync suggests or activates a Thought is based on the current 
Preferences settings (explained below). 

Say that ESP Sync is in “automatically activate” mode and you are composing an 
email message to a friend. You don’t recall her husband’s name and you’d like to 
include it in your message. Assuming you’ve entered that information in the Note 
for her Thought, your Brain would automatically find it for you as you finish typing 
her name by pressing the space bar or any other terminator.  
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Figure 126. A Thought Activated by ESP Sync 

 
By default, ESP Sync is case-sensitive, so it will be looking for matches based on 
the capitalization you use. You can turn this sensitivity off (see below). 

With ESP Sync in “automatically activate” mode, if you copy a file that is attached 
to a Thought on your hard drive, that Thought will be activated. So, to activate a 
Thought that is link to a file, you can right-click it and click the Copy command on 
the context menu (you don’t ever have to actually paste the file anywhere). This 
is a convenient feature when you find a file using an external search application 
such as Google Desktop and then want to see it in your Brain. 

Setting ESP Sync Preferences 
By default, ESP Sync is on in Suggestion mode, but you can de-activate it as 
well as change how it behaves. To view or change the current settings, click the 
Options menu, click the Preferences command, then click the UI icon. Or, right-
click a blank area of the Plex, click Preferences in the context menu, then click 
the UI icon. 
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Figure 127: ESP Sync Options in the UI Section 

To turn ESP Sync off: 

 Uncheck Monitor clipboard 

To turn case-sensitivity off: 

 Uncheck Ignore text that is all lowercase  

To request that a Thought found by ESP Sync stays active beyond one minute 
even if you don’t click within your Brain: 

 Uncheck Cancel if not used within 1 minute  

To have ESP Sync automatically activate a Thought instead of only making a 
suggestion: 

 Open the drop-down Activation list and select Automatically activate  

To have ESP Sync only suggest a Thought instead of making it active: 

 Open the drop-down Activation list and select Suggest only  
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Using PersonalBrain Tools 

You can think of each of PersonalBrain’s seven Tools as a personal assistant 
who is ready to help when asked. You can give any of them the day, week, or 
year off if you choose not to use their services, but they’re all standing by, ready 
to assist you—-at the click of your mouse. 

 
Figure 128. PersonalBrain’s Seven Tool Tabs 

Tools Overview 
Each of the seven Tool tabs can be displayed on any side of the PersonalBrain 
window. You can change their size to suit your preferences. Here are general 
guidelines that apply to all Tools: 

 To access a Tool, click its tab. For example, to access the Calendar Tool, 
click the Calendar tab. 

 To enter information using a Thought-specific Tool, activate the Thought, 
then click the Tool’s tab. 

 To view Thought-specific Tool information for a particular Thought, use the 
mouse to point to that Thought and highlight it. If no Thought is highlighted, 
the information displayed is for the active Thought. Because the Search Tool 
and the Reports Tool do not pertain to specific Thoughts, their window 
content is not affected by the active or highlighted Thought. 
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Figure 129. Some Tools Pertain to Specific Thoughts 

 To make the Tools window taller or shorter: Point at the area just above 
the Tools window. When the sizing mouse pointer appears, drag up or down 
to make the window taller or shorter. 

 To make a Tools tab wider or narrower: Drag the middle border left or 
right. 

 
Figure 130. Sizing the Tools Window 
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 To separate a Tool from other Tools: Drag its tab to the side of the Plex or 
any other Tool pane. You can drop tabs on the side area of any pane to move 
the associated Tool there. 

 
Figure 131. Docking a Tool in the Plex 
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 To merge a Tool into another Tool’s window: Drag its tab to the center of 
another Tool’s window. 

 
Figure 132. Merging a Tool with Other Tools 
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 To maximize or restore a Tool: Double-click on the Tool’s tab. 

 
Figure 133. Maximizing and Restoring a Tool 

 

The Pro Edition allows advanced layout options for the Tool tabs, including 
auto-hiding and floating the tabs. To enable advanced layout options, click the 
Options menu, then click the Advanced Tools Layout option.  

These three buttons are available in the right side of each Tool in Advanced 
Tools layout: 

 

 Tip: Click the Reset Tools Layout command on the Options menu any time to 
restore the Tools to the default layout. 
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Figure 134. Restoring the Default Tool Tabs Layout 

Notes 

 
Figure 135. Notes Tab 

Notes associated with a Thought are visible when the Notes tab is active. They 
can be extremely useful for annotating or expanding information about your 
Thought. 

 
Notes are HTML-based, making it easy to embed hyperlink, images, and more. 
Also, HTML-based notes can be conveniently published on the Web.  

Using Notes Menu Commands 
The menu bar at the top of the Notes tab contains menus that pertain only to 
Notes. Some commands are global for all Notes and some apply to just the 
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active note. For example, all View menu commands pertain to Notes for all 
Thoughts while the Format menu commands pertain to the specific Note that is 
active.  

 
For details about all commands on all Notes Tool menus, please see the 
PersonalBrain Lookup Reference for All Commands guide. 

Using the Notes Toolbar 
The Notes toolbar includes tools for basic word processing activities. You’ve 
probably used many of these buttons before in multiple applications.  

 
Figure 136. Notes Toolbar 

Entering Notes 
To enter a Note, activate the Thought to which the Note pertains, then click in the 
open area below the Notes toolbar buttons and begin typing. By default, text 
appears in Design view, but you can switch to the HTML view if needed. 
Optionally, you can select a different typeface, font size, text color, or other 
attribute first, and then begin typing.  

 
Notes are saved automatically when another Thought is activated.  

The standard techniques you use in other text editors when you type, revise, and 
format in PersonalBrain Notes: 

 Allow automatic word wrapping to control line endings, except when you want 
to begin a new paragraph—press the Enter key to begin a new paragraph. 

 If you want to change the appearance—type face, size, color, highlighting—
and want to have control over exactly which text becomes formatted, select 
the text first. 

 Standard text selection techniques work in Notes: 

♦ Drag the mouse through text to select it, or 

♦ Click at the beginning of the text, then hold down the Shift key as you 
click at the end of the text to select all text in between, or 

♦ Double-click to select an entire word, triple-click to select an entire line 

 Standard keyboard shortcuts—such as Ctrl-C for Copy, Ctrl-V for Paste, 
and Ctrl-A for Select All—work as you would expect in Notes. (On Mac OS, 
the standard Command key shortcuts also work.) You can copy and paste 
within Notes and between PersonalBrain and other applications.  
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One special feature for PersonalBrain Notes is that if no text is selected and you 
select a formatting command such as bold, highlighting, or change in typeface or 
font size, the formatting will apply to the entire word in which the cursor is 
currently blinking. 

 Tip: You can press Ctrl-Z (or click the Edit menu, then click the Undo 
command) to immediately undo your most recent action in Notes. 

Saving Notes 
While Notes are saved automatically when another Thought is activated, if you 
are typing a note that is very long you may want to perform manual “interim 
saves” to guard against losing information in the event of a power failure. 

To save a note manually:  

1. Click the File menu within the Notes tab. 

2. Click the Save command. 

 
Figure 137. Notes Saved Message 

A “Notes saved” message will appear in the upper-right area of the Plex to 
confirm the success of your action. The Save command will be grayed in the File 
menu until you make a new change in the active Note. 

 Tip: Ctrl-S is the keyboard shortcut for saving the active Note. 

Printing Notes 

 To print the active Note, click the File menu within the Tools window, then click 
the Print command. The Print dialog box will open and you can fine-tune your 
print request. 

Checking Your Spelling 

 A spell checker is automatically at work for your Notes. Potential misspellings are 
automatically highlighted and you can right-click to view suggested spellings. 
Click the suggestion of your choice to replace the misspelled word. You can 
customize the dictionary by adding words to it. 
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Figure 138. Spell Checker in a Note 

If you prefer not to see misspellings flagged as you type: 

1. Click the Tools menu in the Notes tab. 

2. Click the Disable Check Spelling As You Type command. 

 
Figure 139. Disabling Spell Checking 

 

This is a toggle command. When you want to turn the feature on again, click the 
Tools menu and click the Enable Check Spelling As You Type command. You 
can always check spelling manually by clicking the Check Spelling command. 

Copying Formatting 

 You can use the Format Painter button to copy formatting you’ve used in a Note 
to other text within the same Note. You may have used a Format Painter button 
in other applications and it works similarly. 

1. Use the mouse to select one or more characters that have formatting you 
want to copy (or just click within text that has the formatting you want to 
copy). 

2. Click the Format Painter button. 
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3. Select the text that should receive the formatting. 

 
Figure 140. Format Painter Button 

Inserting Tables 

 You can insert tables into your Notes. 

1. Click where you want the table to be inserted within the Note. 

2. Click the Insert menu, then click the Insert Table command. The Insert 
Table dialog box will be displayed. 

 
Figure 141. Insert Table Dialog Box 
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3. By default, the table will have two rows and two columns. You can change 
these settings or any of the other default settings to suit your needs. Click 
the OK button when the settings are as you want them to be. 

4. Unless you’ve changed the default settings, the table will span 100% of the 
Note width. You can change the width of any column by dragging the 
vertical bar on the right border of the column. 

 
Figure 142. Changing Column Width 

 Tip: Wait for the mouse pointer to appear as a double-headed arrow before you 
try to drag a column border. 

If you are accustomed to using tables in other applications, the techniques will be 
very familiar to you: 

 Move from cell to cell: Press the Tab key 

 Add a new row to the end of the table: Click in the last cell, then press the 
Tab key 

 Delete a row or column: Select the row (by dragging through it or pointing at 
its left-most border) or select the column (by dragging through it or pointing at 
its top-most border), then press the Delete key 

 
Figure 143. Selecting Table Rows or Columns 

 Format table content: Select the table cells (by dragging or pointing) then 
apply text formatting as usual, using the buttons in the Notes tab 

Embedding Hyperlinks 
You can insert hyperlinks into your Notes and use them to open Web pages or 
email addresses.  

1. Click the Insert menu, then click the Insert Hyperlink command. 
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2. Enter the text you want to see in the Note in the Text to display field. 

3. Either paste the address (if you have copied it from the address bar when 
the site was open) or type the address in the Address field. 

 
Figure 144. Insert a Hyperlink in a Note 

4. Click the OK button. 

 
Figure 145. Appearance of a Hyperlink in a Note 

 
To use the hyperlink once it’s embedded in your Note, hold down Ctrl while you 
click the link. 
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Adding Images to Notes 
You can add images to Notes by using standard copy and paste techniques. Just 
copy the image, then click in the Note where you want the image to appear and 
paste. You can also copy and paste from your browser and usually both images 
and text from Web pages will be added to Notes. 

 

Images are stored in the Thought's folder in a sub-folder called “PersonalBrain 
Notes.” When first added, images may be located in a temporary folder, 
however, PersonalBrain moves these images into the appropriate folder when 
you activate a new Thought. Images copied from Web sites may be referenced 
via their original location online. If the “Save images from the Internet locally” 
option is selected in the General section of the Preferences dialog box, then 
these images will be downloaded to the local Notes folder in the background. 

Counting Your Words 
You can find out how many words and characters are in the active Note. 

1. Click the Tools menu in the Notes tab. 

2. Click the Word Count command. 

 
Figure 146. Counting Words 

3. When you are finished looking at the information in the Word Count 
message box, click the OK button. 

 
Figure 147. Word Count Message Box 
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Properties & Attachments 

 
Figure 148. Properties & Attachments Tab 

All properties and attachments associated with a Thought are visible when the 
Properties & Attachments tab is active. This offers a central, consolidated 
location for viewing and managing a Thought’s name, type, display 
characteristics, label, tags, and attachments. 

Using the Properties & Attachments Toolbar 
Here is an overview of what you can accomplish using the buttons in the 
Properties & Attachments tab.  

 
Add Attachment: Create a new file or attach an existing 
file, folder, or URL. 

 
Open Folder: Open the folder that contains all internal files 
for the Thought. This folder is also referred to as the “GUID” 
(Global Unique Identifyting Directory). 

 
Open Attachment: Open the currently-selected attachment 
in list. 

 
Delete Attachment: Delete the currently-selected 
attachment in list. 

 
Copy Attachment: Copy the currently-selected attachment 
in list to the clipboard. 

 
Cut Attachment: Copy the currently-selected attachment in 
list to the clipboard and delete it from its current location. 
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Paste Attachment: Place the clipboard contents into the list 
of attachments. 

Keeping Properties & Attachments Open 
You can keep multiple Properties & Attachments windows for multiple Thoughts 
open at once. This may come in handy when you want to transfer attachments 
from one Thought to another or when you just want to keep one Thought’s 
properties open for reference. 

To open a Thought’s Properties & Attachments in a separate window: 

 Right-click the Thought, then click the Properties & Attachments command 
on the context menu 

A separate Properties & Attachments window will open. You can move and 
size this window as you would other windows. Close the window by clicking its 
close [X] button when you no longer need it open. 

 
See Adding Files, Web Pages, and Folders beginning on page 83 for more 
information about working with attachments. 

Tags 

 
Figure 149. The Tags Tool 

Tags are useful for flagging Thoughts that you want to be able to reference as a 
group, but don’t want to have to share a common parent. For example, you may 
want to create a “To do” tag so you can get a list of all of these Thoughts very 
quickly. Almost everything related to tags can be done from the Tags tool. Tags 
can be created, deleted, edited, assigned, and activated from here. 

Thoughts can have one or many tags at the same time. Thought tags are global 
for a Brain and can be toggled on and off for the active Thought in the Tags tool. 

Each tag that is applied to the active Thought is displayed in bold and with the 
check box filled. A number to the right of each tag’s name indicates how many 
Thoughts that tag has been applied to. 
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Creating a Tag 
1. Click the Tags Tool. 

2. Click the Create Tag button. 

3. Type a name for the new tag and then click OK. 

The new tag will appear in alphabetical order in the tab and will be assigned to 
the active Thought. 

Assigning and Removing Tags 
1. Right-click the Thought to or for which you would like to add or remove a tag. 

2. Open the Tags submenu from the context menu. Tags assigned to the 
Thought are shown with a check next to them. Click the tag of your choice to 
toggle its status. 

 

Tags appear in the Plex once they have been attached. 

 

Alternatively, you can also activate the Thought and then use the Tags tool to 
click the check box next to the tag you want to change. This method is preferable 
if you have many tags you want to change on a single Thought. 
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If you want to assign tags to multiple Thoughts at once, first select them, then 
right-click on the selection. The Tags submenu also appears on the selection’s 
context menu. 

Deleting a Tag 
1. Open the Tags Tool. 

2. Select the tag to be deleted, then click the Delete Tag button. (Or, optionally, 
right-click the tag and then click Delete Tag.) 

3. Click the Yes button to confirm the deletion. 

 Deleting a tag removes it from your entire Brain. 

Renaming a Tag 
1. Click the Tag Tool tab. 

2. Click the check box next to the tag to be renamed, then click the Tag 
Properties button. (Or, optionally, right-click the tag and then click Tag 
Properties.) 

3. Make any revisions to the tag name and then click OK. 

 Renaming a tag changes its name throughout your entire Brain.  

Defining How Tags will Display 
A “hint” can constantly display the tag name in small print, next to the Thought in 
the Plex. 

To hide all hints: 

1. Click the Options menu, then click the Preferences command. (Or, 
optionally, right-click a blank area in the Plex, then click Preferences.) 

2. Click the Look & Feel button at the top of the Preferences dialog box. 

3. Click the Hide tag hints check box.  
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Figure 150. Hiding or Showing Tag Hints 

 
If tags are hidden globally, no hints will display. However, if tags are not hidden 
globally, individual hints may be hidden (or unhidden) on a tag-by-tag basis. 

 

To hide one specific hint: 

1. Make sure that “Hide tag hints” is NOT selected in “Look & Feel” section of 
the of the Preferences dialog box. 

2. Click the Tag Tool tab. 

3. Click the check box next to the tag hint to be hidden, then click the Tag 
Properties button. (Or, optionally, right-click the tag and then click Tag 
Properties.) 

4. Click the check box next to “Show hint in Plex” to remove the check mark and 
then click OK. 

To change the text color of a hint: 

1. Click the Tag Tool tab. 

2. Click the check box next to the tag hint to be colored, then click the Tag 
Properties button. (Or, optionally, right-click the tag and then click Tag 
Properties.) 

3. Click the Set Color button, click on the color of your choice, and then click 
OK. 
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4. Click OK again to save your change or click the Remove Color button if you 
change your mind. 

Displaying Thoughts Based on Their Tags 
You can show all Thoughts with the same tag by using Instant Activate or by 
using the Tags Tool tab. 

To Use Instant Activate: 

 Begin typing the tag name in the Search field, then click the tag name as 
soon as it appears. Tags are indicated using a special icon and are colored 
using the hint color assigned to them. 

To Use the Tags Tool: 

 Click the name of the tag to activate it in the Plex. 

Once you have activated a tag, it appears in the Plex as the active Thought with 
all the Thoughts it applies to shown as children. These “tag Thoughts” can be 
pinned for fast reference. Also, linking or unlinking a tag Thought adds or 
removes the tag to/from the linked/unlinked Thought. 

Reporting on Tags 
The reports tool now contains an additional drop list that allows you to generate a 
report of all Thoughts with a specific tag. Once a report is generated, it can be 
used to select all of the tagged Thoughts by clicking the Edit menu then Add 
Report Results to Selection. 

 
Figure 151. Reporting Based on Tags 

Converting Parent Thoughts into Tags 
If you have been using parent Thoughts to group information such as “To do” 
items where you have many Thoughts all under a single parent which functions 
similarly to how a tag works, you can convert the Thought into a tag. 

1. Right-click the parent Thought that you want to convert to a tag. 
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2. Click Convert to a Tag in the context menu. This menu entry will not appear 
if the selected Thought does not have any children. 

3. Click OK to delete the Thought or click Cancel to keep the Thought. If you 
click Cancel, the tag is still created but the original Thought is not removed. 

Converting Tags into Parent Thoughts 
Conversely, you can also convert tags into parent Thoughts. To do so, right-click 
on a tag from the Tags tool and select Convert to Parent Thought. All Thoughts 
previously tagged with the tag you just right-clicked will become children of a new 
parent Thought that will have the same name as this tag, and the tag itself will be 
removed. 

Details 

 
Figure 152. Details Tab for a Thought 

Thought details are displayed on the Details tab for every Thought, including the 
date and time of the most recent modification to the Thought, the total size of the 
Thought’s attachments, date and time of original creation, internal identification 
number, and GUID (the folder containing the Thought) identification. 

These values may be used for future integrations when publishing content or 
interfacing with PersonalBrain through an application program interface (API) or 
an XML file. 

To view this information for any Thought: 

1. Either point to or activate the Thought. 

2. Click the Details tab. 
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When a Thought’s attachments are modified, the modification date of the 
Thoughts is also automatically updated, improving the accuracy of your searches 
and filters.  

Search 

PersonalBrain includes powerful search capabilities. You can: 

 Search for a Thought and activate it instantly—the Instant Activation 
feature lets you quickly find a Thought by typing a few letters, and choosing 
from a list of “hits.” After you click the Thought of your choice, that Thought is 
automatically activated. 

 Search within Notes—a robust full text index provides a fast natural 
language search through all of your notes. 

 Search within attached Web pages—your searches will automatically 
extend into any Web pages you have attached to your Thoughts. 

  Search within attachments—your searches automatically 
include the contents of attachments. If the text you’re searching for exists 
within documents including PDFs, Word, Excel, PowerPoint and many other 
file formats, the documents containing the text will be found. 

 
Figure 153. Search Tab Before a Search 

If you click the Search tab before searching for something, it looks like Figure 
153 (above). As soon as you perform an extended search, additional features 
become available, as shown below. If a search result is a Thought in your Brain, 
clicking on it in the results list activates that Thought. 
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Figure 154. Search Tab After an Extended Search 

Using the Search Toolbar 
Followng is an overview of what you can accomplish using the buttons in the 
Search tab.  

 
Under Active: When selected, limits possible search results 
to the active Thought and its child Thoughts. 

 
In Selection: When selected, limits possible search results to 
Thoughts in the Selection box. (When you Ctrl-click on one 
or more Thoughts, the names of each of these Thoughts 
displays in the PersonalBrain Selection box.) 

 

Sort: Search results may appear in order based on their 
relevance or by date modified (how recently the item was 
revised). 

 
Clear Results: The search results are removed and only the 
Advanced button remains in the Search tab. 

 
Advanced: Opens the Advanced Search dialog box to let 
you fine-tune your search further. 

Performing an Extended Search 
To perform an extended search: 

 Type what you’re looking for in the Search field, then click the Search button 
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Your Search results will appear in the Search tab. The terms you searched for 
are highlighted in yellow in the results list. By default, the most relevant items 
appear first on the list—that is, the items you that have the most content relevant 
to the terms you searched for.  

Alternately, you can use the Sort drop-down list to order the list of results by the 
dates the items were last modified. 

 
Figure 155. Search Results 

Click on any link in the Search results to go directly to the item, whatever it may 
be. For example, in the second found item above, clicking on “Improv” would 
activate the Thought named “Improv” (whose parent is “Theatre”) and clicking on 
the URL shown in green type would open that Web page in your browser. 

Fine-Tuning Your Extended Searches 
Your Brain makes certain assumptions automatically: 

 You don’t want common words that occur in most documents—a, an, or, the, 
you, it, to, etc.—to be included in the search 

 You would like variations of the word you’re searching for to be included in 
the search 

Example: You enter the word swim—PersonalBrain looks for swim, swims, 
swimming, and swam 

 You don’t care in what sequence the words you’re looking for appear 
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Example:  You enter the words change directions—PersonalBrain also 
looks for sequences such as “change in directions,” “direction 
changes,” and “changing his direction” 

 If you do care in what sequence the words you’re looking for appear, indicate 
this by using quotation marks 

Example:  You enter the words “change directions”—within quotation 
marks—PersonalBrain will not find sequences such as “change in 
directions,” “direction changes,” and “changing his direction” (but 
will find occurrences such as “change directions,” “changing 
direction,” and “change directional”) 

The following are other ways to customize your searches: 

To do this … Do this … 

Make one or more search 
terms optional 

Type OR (in upper-case letters) between the 
terms 

Example: dinner OR lunch OR restaurant 
will find all items that have ANY of these terms 

Make some search terms 
required and some terms 
optional 

Use a combination of AND and OR between 
terms and type parentheses to indicate priority 

Example: (dinner OR lunch) AND restaurant 
will only find items that contain “restaurant,” 
but some items may also include “dinner” or 
they may also include “lunch” 

Eliminate search results that 
contain specified search terms  

Type NOT (in upper-case letters) before the 
term 

Example: restaurant NOT brunch will only 
find items that include the term “restaurant” but 
do NOT include the term “brunch” 

Search for all terms starting 
with specified characters 

Type an asterisk (*) after the term 

Example: car* will find terms such as card, 
cart, cartilage, and carriage 

Search for all terms starting 
with specified characters and 
ending with only one character 

Type a question mark (?) after the term 

Example: ten? will find terms such as tent and 
tens 

Using Advanced Search Features 
You can use the Advanced Search feature to fine-tune your search to increase 
the likelihood of finding exactly what you’re looking for.  
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1. Click the Advanced button in the Search tab. 

 
Figure 156. Advanced Search Dialog Box 

 You can toggle which types of information you wish to search through, 
which enables searching only tags and name for example while 
ignoring attachments and notes. 

 Type information in any of the first four fields, none of which are case-
sensitive, and/or  

 Select a Thought type from the drop-down Thought Type list, and/or  

 Select the second radio button for Modified Since (which will limit the 
search to items that were modified since the date you specify) 

2. Click the OK button to begin the search. 

 

The more fields you use in the Advanced Search dialog box, the fewer results 
will appear. Each field has an “and” relationship with the other fields. In order to 
qualify for being included in your results, items will need to match ALL of the 
conditions you specify—whatever is in the All of the words field AND in the 
Exact phrase field, and so on. 
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 Tip: Here are ways you can use the Advanced Search dialog box fields: 

 All of the words: Type any words that all MUST be included in the item(s) 
you want to find. Separate each word with a space, comma, or semi-colon.  

 Exact phrase: Type one or more words exactly as they must appear in the 
item(s) you want to find. You don’t need to enter punctuation and remember 
that none of these fields are case-sensitive. 

 At least one of the words: This is an “either/or” field. If you type multiple 
words here and an item includes one or more of them, but not necessarily all 
of them, the item is a valid candidate for matching your search conditions. 

 Thought Type: If you are searching for Thoughts that have an assigned type, 
select the type from the drop-down list.  

 Modified Since: By default, the search will ignore the date on which items 
were last modified. Optionally, select the alternate radio button which will 
allow you to specify a date. 

 
Figure 157. Sample Results of an Advanced Search 

Notice that when PersonalBrain displays the results of your Advanced Search, 
you have an opportunity to check what you requested. Your search criteria 
displays after the “Search results for” heading at the top of the Search results 
window. This makes it easier to trouble-shoot any unexpected results. 
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Hyperlinks inside of Thought Notes are also searchable. For example, if a link to 
www.yahoo.com is added to a Note, but this link is not part of the text (such as: 
<a href=”http://www.yahoo.com>my link</a>), searching for “yahoo” will find this 
Note. 

Customizing How Search Results are Handled 
Use the Search tab in the Preferences dialog box to manage how search results 
are handled. (Click the Preferences command on the Options menu to open the 
dialog box.) 

 
Figure 158. Search Tab in the Preferences Dialog Box 

 Select the Merge Thought and content results check box to 
consolidate Search results into a single list instead of showing 
Thought name matches separately 

 Select the Only display one search result per Thought check box 
to only show the single most relevant occurrence of the search terms 
within a Thought regardless of how many different places the terms 
may appear in the Thought 

 Click the Maximum file size to index drop-down arrow to select the 
largest file size you want to allow to be indexed; enabling larger files 
to be indexed gives greater coverage, but may provide less relevant 
results in some cases
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iCal, Address Book, and Mail Integration 

 
PersonalBrain integrates with iCal, Address Book and Mail. To link to an item in 
one of these applications, do a search from PersonalBrain. The search result will 
automatically display matches for content within all of these applications. These 
special results show in the External Mail, Address Book, and iCal Items 
section. 

 
Figure 159. External Mail, Address Book, and iCal Items 

A search result from one of these applications has an Open and an Add button. 
Clicking Open opens the particular item in the appropriate application. Clicking 
Add button creates a new child Thought from the active Thought with a link to 
the item. Click on the icon next to the Thought to open its attachment and get 
instant access to the information inside of iCal, Address Book, or Mail. Of course, 
these Thoughts can be linked and used like any other Thought in PersonalBrain. 
Optionally, you can even drag and drop or copy and paste the attachments from 
these Thoughts to other Thoughts. 
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Reports 

 
Figure 160. Reports Tab 

The Reports tab provides another way of seeing the contents of your Brain and 
activating Thoughts quickly. 

When you click the Reports tab, you see a list of Thoughts with their icons and 
colors set according to their properties. Clicking on a Thought in the list activates 
that Thought. The bars to the left of each Thought provide a visual cue for how 
many times you’ve activated each Thought in the last 30 days—the wider the 
bar, the more times you’ve activated the Thought. The total number of Thoughts 
currently showing is provided in the bottom-left corner of the window. 

Customizing Reports 
You can customize the contents of the report in a number of ways: 

 Limit types: Click the drop-down arrow button for types to limit the report to a 
specific Thought type. 

 
Figure 161. Selecting Specific Types for the Report 

 Limit tags: Click the drop-down arrow button for tags to limit the report to 
Thoughts with a specific tag. 
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Figure 162. Selecting Thoughts with Specific Tags for the Report 

 Limit based on attachments: Click the third drop-down arrow button, then 
select the attachment type of your choice. 

 
Figure 163. Running Reports Based on Attachment Types 

 Limit dates: Click the drop-down arrow button for dates to limit the report to 
specific Thought activation, modification, or creation dates. As soon as you 
select one of these options, a calendar will be displayed so that you can 
easily select a date. 

 
Figure 164. Selecting Specific Dates for the Report 

 Specify sort order: Click the Sort drop-down arrow button to specify in what 
sequence you want the report data to be displayed. 
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Figure 165. Changing Report Sort Order 

 
Keep in mind that the date options for the Sort field are separate from the date 
options for filtering the Report contents. Sorting and filtering provide separate 
ways of fine-tuning report results. 

 
 Specify “from/to” date ranges: You can indicate both a start date and end 

date to further fine-tune the content of Reports. Click the drop-down arrow 
button dates, then click on any of the options except “All dates.” A default 
start date and end date will appear in two separate fields. Click on either or 
both of the date fields to display a calendar from which you can select a 
different date. 

 
Figure 166. Date Filter Options 

 Refresh report data: Click the Refresh button to update the list of Thoughts 
that match your report criteria. 

 
Figure 167. The Refresh Button 
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Calendar 

 Your Brain has its own built-in Calendar. You can add and modify events that are 
integrated with your Thoughts. You can view your Calendar a day, week, month, 
or year at a time. 

 
Figure 168. Calendar Views 

 Click an event on your Calendar to automatically activate the Thought with which 
the event is associated.  

Adding an Event 
All events must be associated with a Thought, so before you add an event, 
decide which Thought it belongs with or create a new Thought if needed. 

1. Activate the Thought with which you want the new event to be associated. 

2. Click the Calendar tab. The view will be as you left it the last time you 
accessed your Calendar—you will see a day, a week, a month, or twelve 
months in the left panel of the Calendar tab.  

 
Figure 169. Add Event Button 
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3. Click the Add Event button.  

4. Type the description of the new event in the empty field in the “Event” 
column on the right-side panel of the Calendar tab.  

5. Whatever date was selected on the Calendar in the left panel will appear in 
the “Date” column. To change the event date, click on it in the right panel. A 
calendar will display just below the new event. Use this calendar to select a 
new date for the event, if necessary. 

6. Optionally, click “Unspecified” in the Time column and select a time. The 
event will appear on the currently selected day in the Calendar. 

 
Figure 170. Selecting an Event Time 

7. You can change the priority of the event by clicking the dot to the left of the 
event name and selecting the red up-arrow (high priority) or the blue down-
arrow (low priority). Re-select the dot to leave the priority set as normal. 

 
The priority you assign to an event will determine the color in which it displayed 
on the Calendar. 
 

 
Figure 171. Changing an Event’s Priority 

The check box to the left of the priority indicator is for marking the event as 
complete, so you probably won’t use it at the same time that you create an event.  
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To change the default date for new events, you can click on a day in the 
Calendar. The current default day is displayed in blue. To make today the default 
day, click the Today button above the calendar. 

 Tip: Remember to activate the relevant Thought before you add an event to the 
Calendar so that the event is automatically connected to the Thought. 

Viewing Events 
 When there are too many events to be displayed in the current view, an arrow 

followed by the number of hidden events is displayed. Click on this arrow to 
move to the day view and show the events. 

 Event descriptions that are too long to show are displayed in full when the 
mouse points at them. 

 
Figure 172. Reading Event Notes 

Navigating Your Calendar 
Whether you’re looking at your Calendar a day, week, or month at a time, each 
view has a back and forward arrow for moving one unit of time in the associated 
direction. For example, if you are looking at a week view, click the forward arrow 
to see the following week. 
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Figure 173. Moving Backward and Forward 

Clicking the Calendar’s header changes the Calendar to the next larger unit of 
duration. For example, if you are in week view and you click on the week 
indicator at the top of the Calendar, you will see the Calendar for the whole 
month. Similarly, if you are in month view and you click on the month indicator at 
the top of the Calendar, you will see all the months in the year. You can move 
forwards and backwards between years by, again, clicking the back and forward 
arrows. 

You can also go directly to a different year by revising the year in the edit box 
that appears when you click on the year label at the top of the calendar. 

 
Figure 174. Changing the Year 

Marking Events as Complete 
You can mark Calendar events as complete by clicking the check box to the left 
of the event’s priority indicator. Clicking the check box a second time removes 
the completion check mark. Once the event is marked as complete, associated 
reminders will no longer display. 
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Figure 175. A Completed Event 

 
Completed events are automatically crossed off in the Calendar. 

Deleting an Event 
To delete an event on the Calendar, click on it and then click the Delete button. 
You can delete multiple events at once by holding down the Ctrl key as you click 
each event to select non-adjacent events, or click the first event in the list and 
then hold down the Shift key as you click the last event to be included in the 
selection. All selected events will be deleted when you click the Delete button. 

 
Figure 176. Deleting an Event 

Snoozing and Dismissing Events 
Events can be individually snoozed and dismissed in the Past Due Reminders 
dialog box. Click the row for the entry of your choice, then click the Dismiss or 
Snooze button. Optionally, select when you want to be reminded in the Remind 
again in field. 

 
Figure 177. Dismissing or Snoozing Individual Events 
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Printing Your Brain  

You can print views of your Brain easy and accurately. 

 Printing huge views scaled across multiple pages is supported for up to 100 
pages. Your Brain may fill an entire wall! 

Regardless of the number of pages you select for your print action, all Thoughts 
that are currently displayed in the Plex will be included in the print version. 

To specify how your Brain will be printed: 

1. Make sure that all Thoughts that you want to print are visible in the Plex. To 
print many Thoughts at once, switch to expanded view (see Using 
Expanded Thoughts View on page 100) first and expand the areas you 
want visible. 

2. Click the File menu, then click the Page Setup and Multi-Page Poster 
Printing command. The Page Setup dialog box will be displayed: 

 
Figure 178. Page Setup Dialog Box 
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3. If appropriate, change settings for paper size, orientation, or margins, then 
click the OK button. The Print Settings dialog box will be displayed: 

 
Figure 179. Print Settings Dialog Box 

4. Select the number of pages you would like your Brain to span, then click 
the OK button. 

When you use the Print command on the File menu to actually print your Brain, 
these settings will be in effect.  
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Using Outlook with Your Brain 

  You can integrate Microsoft Outlook messages, contacts, journal items, 
and meeting notes into your Brain. You can drag and drop any of these items into 
your Brain and they will be maintained as links directly to the original item inside 
of Outlook. 

 
These features apply only to Outlook and are not applicable to Outlook Express. 

Adding Contacts to Thoughts 
Contacts added to your Thoughts are automatically linked directly to the original 
item inside of Outlook. 

1. Activate the Thought with which the Contact will be associated. 

2. In Outlook, navigate to the Contact of your choice and drag it to your Brain. 
Drop the Contact in an empty area of the Plex to create a new Thought or 
drop it on top of an existing Thought to add an attachment for the Contact 
to that Thought. 

 
Figure 180. Adding a Contact to a Thought 
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The Contact will be added as a child of the active Thought. When you open the 
attachment, the Contact will open inside of Outlook. 

You can also add multiple Contacts at the same time. Hold down the Shift key as 
you click on each Contact, then drag the selected Contacts into the Plex all at 
once. 

Adding Messages to Thoughts 
Messages added to your Thoughts are automatically linked directly to the original 
item inside of Outlook. 

1. Activate the Thought with which the message will be associated. 

2. In Outlook, navigate to the message of your choice and drag it to your 
Brain. The message will become a child of the active Thought. You can 
also drop a message on top of an existing Thought. 

 
Additionally, a text copy of the message will be pasted into the Note for this 
Thought. 

 
Figure 181. Adding a Message to a Thought 

Adding Other Outlook Objects with Drag and Drop 
In addition to contacts and messages, many other items can be dragged from 
Outlook into PersonalBrain. The list of supported objects includes: 

 Messages 

 Contacts 

 Journal Items 

 Meetings 

 Notes 

 Appointments 

 Tasks 
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Copying Contacts into Notes 
You can also drag a contact into the Notes tab of the active Thought to insert the 
contact details into notes. 

Emailing Attachments 

You can email any Attachment in your Brain as an Outlook attachment. 

 Right-click on any attachment and click Email Attachment Using Outlook 
on the context menu. Outlook will open automatically (unless it is already 
open) and start a new message. The attachment will be added to the 
Attachment list. 

 
Figure 182. Email Attachment Using Outlook Command 

You can also drag attachments from the attachments list in PersonalBrain to 
messages you have already started composing in Outlook and they will be added 
as attachments. 
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Using Web Mail with Your Brain 

The following sections describe how your Brain can integrate information with 
Yahoo!® Mail and Gmail™. The first step is the same, no matter which Web mail 
program you are using: 

 Activate the Thought that will be the parent of the Yahoo! Mail or Gmail 
content. 

Adding Contacts to Thoughts 

Yahoo! Mail Description 

 Drag the screen name link for the contact from the Contacts tab 
in Yahoo! Mail into the Plex. The new child Thought will be 
named “Sign in to Yahoo!” and it will automatically have an 
attachment with the same name. You may want to rename it 
based on the contact’s name. If you are signed in to Yahoo! Mail, 
opening the attachment will open the contact in the Yahoo! Mail 
program. 

 

To facilitate opening a pre-addressed message to a contact: 
Drag the email address link for the contact from the Contacts tab 
in Yahoo! Mail into the Plex. The new child Thought will be 
named “The best web-based email” and it will automatically have 
an attachment with the same name. You may want to rename it 
based on the contact’s name. If you are signed in to Yahoo! Mail, 
opening the attachment will open a Yahoo! Mail Compose Mail 
window, with a message pre-addressed to this contact. 
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Adding Messages to Thoughts 
Web Mail Description 

Yahoo! Mail Drag the email message’s subject from any Yahoo! Mail folder 
into the Plex. The new child Thought will have a "Yahoo! Mail" 
label and it will automatically have an attachment with the same 

                         name as the Thought. If you are signed in to Yahoo! Mail,  
                         opening the attachment will open the message. 

Gmail With the message open, drag the URL in the Address bar from 
the Gmail window into the Plex. The new child Thought will have 
a "Gmail" label and it will automatically have an attachment with 
the same name as the Thought. If you are signed in to Gmail, 
opening the attachment will open the message.  
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Web Mail Description 

 You can also create a new 
Thought out of any Gmail 
message folder. Drag the 
folder into the Plex. The new 
child Thought will have a
“Gmail” label and it will 
automatically have an 
attachment with the same 
name as the Thought. If you 
are signed in to Gmail, opening 
the attachment will open the 
folder in the Gmail application. 

 

Mac OS X: Email and Other Features 

iCal, Address Book, and Mail Integration 
PersonalBrain integrates with iCal, Address Book and Mail. To link to an item in 
one of these applications, do a search from PersonalBrain. The search result will 
automatically display matches for content within all of these applications. These 
special results show in the External Mail, Address Book, and iCal Items 
section. 

 
Figure 183. External Mail, Address Book, and iCal Items 
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A search result from one of these applications has an Open and an Add button. 
Clicking Open opens the particular item in the appropriate application. Clicking 
Add button creates a new child Thought from the active Thought with a link to 
the item. Click on the icon next to the Thought to open its attachment and get 
instant access to the information inside of iCal, Address Book, or Mail. Of course, 
these Thoughts can be linked and used like any other Thought in PersonalBrain. 
Optionally, you can even drag and drop or copy and paste the attachments from 
these Thoughts to other Thoughts. 

Additional Email Capabilities 
Attachments have an Email Attachment Using Mail command in the context 
menu. This opens Mail and attaches the selected file or files to a new message, 
ready to send. Emailing URLs is also an option. 

 
Figure 184. Email Attachment Using Mail Command 

 
Use Quick Look to preview attachments.The Quick Look command appears in 
context menus for both Thoughts and attachments. Individual attachments can 
be selected on the Properties & Attachments tab, or you can select Quick 
Look from the context menu of a Thought to open all its attachments in Quick 
Look. If multiple files are opened in Quick Look, you can browse through them 
using the arrows at the bottom of the window or click on the index icon to view a 
grid of all the items.  
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Figure 185. Quick Look Command 

Searching File Attachments 
PersonalBrain integrates with Spotlight to provide search results from within files 
that are attached (either internally or as shortcuts) to Thoughts in your Brain. Any 
file that can be indexed by Spotlight and is linked in your Brain will automatically 
be searched whenever you do a search in PersonalBrain. No setup or additional 
steps are required to enable this functionality. 
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Sharing and Exporting Your Brain 

 You can export your Brain in a variety of formats for easy sharing with others. 
The HTML-based export formats can be used to send your Brain to people even 
if they don’t have PersonalBrain on their computers. 

 

To share your Brain, you can either share the exported files over a local network, 
email them, or upload to a Web server. For Web hosting, contact your ISP or 
search for “Web hosting” on the Internet to find a suitable host if you do not 
already have access to a Web server. Any Web server can be used—there are 
no special requirements for hosting an exported Brain. 

Using BrainZip to Send Your Brain to Others 

You can send your Brain as an attachment to an email message. To make the 
attachment as small as possible, you can use PersonalBrain’s BrainZip feature to 
create a compact file with all the information inside your Brain. 

To create a BrainZip: 

1. Click the File menu, then click the Create BrainZip command. 

2. In the Create BrainZip Options dialog box, select or deselect items to be 
included. Only items that are actually in your Brain will be available for 
selection. 

 
Figure 186. Create BrainZip Options 

3. Click the Browse button, if necessary, to change the Output folder where 
the BrainZip will be saved. Then, click the OK button. 

 You will see a progress bar as the files are compressed and the new file will 
have a “brainzip” extension. 
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Figure 187. Saved Brainzip file 

 

BrainZip files are NOT .zip files. The BrainZip format uses zip compression, but 
also optimizes the Brain data in other ways to eliminate redundant information. 
You should not use zip file utilities to modify or access your BrainZip files as 
doing so may corrupt them. 

Exporting Your Brain to a SiteBrain Web Site 
You can place your Brain on the Web—why keep it all to yourself? This export 
format features a fully animated Brain that requires no plug-ins to access. 

 SiteBrain is a technology that creates an animated Web page using Ajax Web 
standards so that it can be quickly and easily seen in most Web browsers. 
The result is a stunning Web site that will both impress your users and help 
them find information more easily. 

 SiteBrains published for individual use that are accessible to everyone via the 
public Web do not require any additional license and can be published free of 
charge from TheBrain.  

 Publishing to a non-Web-based file share or onto a CD or other removable 
media is also free of charge.  

 SiteBrains published to a private intranet for commercial use and SiteBrains 
that incorporate any kind of username/password authentication require that 
you obtain a commercial license from TheBrain.  

 A SiteBrain is compatible with iPhone. The Plex of the SiteBrain window can 
be resized and SiteBrains include the Past Thought list. In addition, the 
SiteBrain has a Search field for finding content within your Brain instantly, 
based on the starting characters of Thought names. 
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To export your Brain as a SiteBrain to a Web site: 

1. Click the File menu, point to the Export submenu, then click the SiteBrain 
HTML with XML Data command. The Export Options dialog box will be 
displayed. 

 
Figure 188. SiteBrain HTML with XML Data Export Options Dialog Box 

2. You can change any of the default settings in the dialog box, as 
appropriate. Click OK to begin the export. 

During the export process, you will see a running indication of the progress. After 
a short time, depending on how big your Brain is, the exported file will open in 
your default browser. You will see a functioning representation of your Brain, 
ready for sharing with others. 

If you export your Brain again later to the same location, only the changes you 
made will be exported. This makes the export process much faster next time. 
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Figure 189. An Exported Brain 

 

 

If you open a SiteBrain in Internet Explorer from a local file, it will show a security 
warning and will not display your Brain immediately. Select the message at the 
top of the window and choose "Allow Blocked Content..." to proceed. There is no 
security risk. 
This warning will not appear once you have placed your SiteBrain on a Web 
server. 
 

 

Brains can also be copied to CDs or USB drives using these steps. Indicate the 
destination of your choice in the Output Folder field or simply copy the output 
files to the location of your choice after the export has completed. 
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Exporting Your Brain as a Simple HTML  
The Simple HTML Export creates a Web site that uses a more conventional 
menu style layout. Content exported using the view may be freely posted to any 
Web server at no charge. 

To export your Brain as a Simple HTML Web site: 

1. Click the File menu, point to the Export submenu, then click the Simple 
HTML command. The Export Options dialog box will be displayed. 

 
Figure 190. Simple HTML Export Options Dialog Box 

2. You can change any of the default settings in the dialog box, as 
appropriate. Click OK to begin the export. 

 During the export process, you will see a running indication of the progress. 
After a short time, depending on how big your Brain is, the exported HTML 
file will open in your default browser. 
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Figure 191. Exported Simple HTML Brain 

Exporting Your Brain as XML for BrainEKP 

PersonalBrain can also export your Brain as a single file containing all the data. 
This format is intended for use with TheBrain’s enterprise product, BrainEKP, 
which offers a multiple user collaborative environment for building an 
organization wide Brain. The resulting file is a PersonalBrain Archive (PBA) file 
which contains XML for all your Brain’s data, HTML for notes, and files for 
attachments. This file format may also be used by some third-party software. 
This format is the same as the format created by the PersonalBrain Exporter for 
PersonalBrain 3. 

To export your Brain as XML for BrainEKP: 

1. Click the File menu, point to the Export submenu, then click the XML for 
BrainEKP command. The Export Options dialog box will be displayed. 

2. You can change any of the default settings in the dialog box, as 
appropriate. Click OK to begin the export. 

Copying Thoughts into Other Applications as an Outline 
You can copy Thoughts from the Selection box into other programs such as 
Microsoft Word or Excel and the Thoughts will be formatted as an indented 
hierarchical list. 
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To copy one or more Thoughts into another program as an outline: 

1. Select all of the Thoughts you want to include in the outline (Ctrl-click on a 
Thought to add it to the selection or use the commands on the Edit menu to 
quickly create a selection). 

2. Click the Edit menu and then click the Copy as Text Outline command. 

 
Figure 192. Copying Thoughts as an Outline 

3. Open the other application and click where the outline version of the 
Thoughts should be inserted. 

4. Right-click and then click the Paste command on the context menu (or click 
the Edit menu and then click the Paste command). 

 
Figure 193. Samples of Outlines Created by Pasting Thoughts from PersonalBrain 
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Importing Information Into Your Brain 

Importing Bookmarks, Folders, and Mind Maps 

 

You can import Internet bookmarks (such as Internet Explorer favorites), folders, 
and Mind Maps into your Brain. When you import a folder, it becomes a child 
Thought of the active Thought.  

To Begin Importing: 

1. Activate the Thought that will receive the imported information. 

2. Click the File menu, then click the Import command. 

For Bookmarks: 

 Click IE Favorites, then click Yes to confirm that you understand this import 
can’t be undone. Each of your favorites will becomes a separate child 
Thought of the active Thought. 

For a Folder: 

 Click Folder, navigate to the folder of your choice, then click the Save button. 
Click Yes to confirm that you understand this import can’t be undone. Each of 
the files in the imported folder will become a separate child Thought of the 
active Thought. 

For a Mind Map: 

 Click MindManager File (.mmap or .xmmap) or FreeMind File (.mm), 
navigate to the file of your choice, then click the Open button. Each of the 
topics or ideas will become a separate child Thought of the active Thought. 

Merging Brains 
You can copy all Thoughts from one Brain to another by using the Merge Brain 
feature. 

1. Open the Brain into which you want to merge another Brain. 
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2. Click the File menu and then click the Merge Brain command.  

 
Figure 194. Merging Brains 

3. Use the Select PersonalBrain File dialog box to choose the Brain you 
want to merge into the active Brain. 

4. Click the Yes button to acknowledge that merging is not an action that can 
be undone. 

5. A progress bar will display as the Brains are merged. When the merge is 
complete, the Thought that was active at the start of the merge will be 
linked to the last active Thought from the merged Brain.  

 
The only Brain that is changed is the one that is open when you begin the merge 
procedure. The Brain you select during step 3 is not changed at all.  

 

Importing PersonalBrainXMLs 
PersonalBrains that have been exported into an XML format (or properly-
formatted XML that has been generated outside of PersonalBrain) can easily be 
imported back into another Brain as a chid of the active Thought. 

1. Activate the Thought that will receive the imported XML. 

2. Click the File menu, then click the Import command. 

3. Click PersonalBrain XML, navigate to the file of your choice, then click the 
Open button.  

Importing Outlines from Word or Excel into a Brain 
You can copy content that has been set up in an outline format within Word or 
Excel into a Brain. Once pasted into the Brain, the content will retain the same 
hierarchical structure as in the source file.  

1. In the source application, select the text to be included, then copy it by 
right-clicking within the selection and clicking the Copy command on the 
context menu (or click the Edit menu and then click the Copy command). 
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If you are using Word, make sure that a hard return (paragraph break) 
separates each paragraph and that the Tab key has been used to indent 
each entry to the proper position. 

 
PersonalBrain offers many other import options such as IE favorites, Firefox 
bookmarks, XML, MindManager files, OPML, FreeMind, and OWL. 

 
Figure 195. Information Ready for Import from Word 

 
Bulleted or ordered lists created in Word 2007 and saved as “.docx” files can be 
imported and will be converted to a hierarchical set of Thoughts for each bullet 
point.  

If you are using Excel, each item that will become a Thought needs to 
be in a separate column and row. Columns are used to indicate the 
level of indentation and show which Thoughts will become children. 

 
Figure 196. Information Ready for Import from Excel 

The information you have entered into the source application will be 
turned into Thoughts. 
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Figure 197. After Importing 

2. In your Brain, activate the Thought that will be the parent of the inserted 
outline, click the Edit menu, and then click the Paste Outline command. A 
progress bar will show the new Thoughts being pasted in. 

 
Figure 198. Pasting an Outline from Another Application 

3. In the event of duplicate names, the Thought Name Exists box will 
display. In this case, select the option of your choice from the drop-down 
list and then click the OK button. 

 
Figure 199. Handing Duplicate Thought Names 

 Click Link to (Thought name) to avoid inserting a new Thought with 
an existing name and, instead, to automatically create a link from the 
existing Thought to the new Thoughts being pasted in 

 Click Create New to allow duplicate Thought names and not link to 
the original Thought with the same name 

 Click Cancel Paste to abort the operation 
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Brain Maintenance 

Backing Up Your Brain 

You can back up your Brain by using PersonalBrain’s BrainZip feature to create a 
compact file containing all the information used by your Brain. Everything in your 
Brain can be recreated from a BrainZip with the exception of externally linked 
files. We recommend storing your backup in a safe location, preferably not in the 
same physical location as your computer in case of a fire or other emergency. 
See the previous section for a description of how to create BrainZip files. 

You can also back up your Brain by simply copying the .brain file and _brain 
folder; however this method will take more time and occupy more storage space. 
See the following section for more information on where your Brain data is 
stored. 

Looking Under the Hood: Where Your Brain Stores Content 

The data for your Brain in stored in the folder that you specified when you 
created it. This defaults to your user folder where your other documents are or 
the “My Brains” folder if you upgraded from an earlier version of PersonalBrain.  

Each Brain you create is stored in a file with the extension “.brain” and folder that 
has a name ending in “_brain.” The file and folder must be kept together in order 
to work properly. If you have named a Brain “Pat Green,” its file and folder will be 
named “Pat Green.brain” and “Pat Green_brain,” respectively. 

PersonalBrain uses its own database to track the relationships between all 
information in your Brain. This database, as well as the search index and other 
information, is all stored inside the _brain folder. Attachments for your Thoughts 
are stored in the “Files” subfolder of the _brain folder. 

The size of a _brain folder depends on how many Thoughts it contains and how 
much content is associated with each Thought.  
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Some Sample Brain Applications 

The following examples are provided to help you get your creative juices flowing. 
Perhaps these ideas will help you design and develop Brains that fit your 
personal needs. Note that topics in these examples could easily all simply be 
sections within a larger Brain. Many people find that keeping a single Brain suits 
their style of working and thinking better than separating information into different 
Brains. 

Project Management Brain 
With PersonalBrain’s visual interface you can create an all encompassing view of 
your projects to see even the most complex relationships more intuitively. Your 
project brain will help you take control of your information and execute more 
effectively. 

 

Create a Thought for each project goal and objective. Under these Thoughts you 
can spin off additional Thoughts with all the resources you need to achieve each 
goal. 

 

You can even create Thoughts for each phase of your project. 
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You can also have a Thought that links all your active projects for fast access. 
For more information on using your brain for project management go to: 
http://blog.thebrain.com/from-ideas-to-action/  

Or, watch our recorded highlights from our last Web event on project 
management at: 
http://www.thebrain.com/site/about/events/projectmanagement/default.html
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Hobby and Special Interest Brain 
Whether it’s baseball, antiquing, or your pet parrot, adding a Thought on your 
latest preoccupation or hobby is very satisfying. You can use TheBrain’s search 
Web feature with your favorite search engine to find the best web sites on your 
hobby. Then drag and drop links into your Brain. Special interests are even more 
special when you can “instant activate” them on a moment’s notice or link to your 
buddy who you are going to the game with.  
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You might be surprised at how quickly you can develop a personal resource on 
your favorite sport or hobby that becomes invaluable to you as you pursue your 
passion. Don’t forget to copy and paste Thought icons to your hobby Thoughts 
for extra pizzazz. This is just plain fun! 

For more information on building a Brain for your special interests, see the “Mind 
Mapping your Passion” recorded event at http://www.thebrain.com/recordings. 
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Travel Brain 
We live in a global village of cities and countries. Even if you’re not a jetsetter, 
this section of your Brain is invaluable to anyone who wants to maximize their 
time in the right places when away from home. Create a Thought for the location 
you are visiting: link to key destination sites, hotels and tourist attractions. For 
instance, if there is a specific hotel you like, drag and drop its Web page into your 
Brain to create a Thought for it. 

 
 

You can also use this area of your Brain to create a list of cities that interest you 
so you can link to activities that you might like to do there sometime down the 
road. In time, you’ll be able to see the places you should visit based on all the 
things you want to see there and the people you want to visit. Plus, when you do 
go you’ll be sure not to have forgotten anything! 
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Personal or Business Finance Brain 
Staying on top of your Finances and planning for the future is a daunting task for 
everyone. Your Brain makes it easy by giving you a complete picture of all your 
upcoming bills, financial assets and research on your future. 

 
 

This is also a great place to link to any online bill paying or banking sites that you 
may use. You can also add a Thought for “Bills paid” and add in any notes on 
dates bills are due or when they were last paid. For more time sensitive and 
important items like property taxes you can create separate Thoughts and set a 
calendar item so PersonalBrain will remind you when they are due. If you are into 
scanning receipts or important documentation PersonalBrain makes it easy to 
store and categorize this information. 

For more information on using your Brain for personal finance, watch our 
recorded seminar at: http://www.thebrain.com/recordings
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Research and Analysis Brain 
PersonalBrain is ideal for aggregating information on hot products, competing 
strategies, and the strengths and weaknesses of your competition. For example, 
in product analysis, often relationships between product genres will cross various 
categories. A product or feature might fit under multiple concepts and ideas, 
crossing genres so to speak. This can only be visualized associatively with one 
Thought having multiple parents and connections. With PersonalBrain the full 
context is captured and powerful analysis is enabled with a few connections. 

 
 

 

For more information on using creating brains to understand your business 
landscape, watch our recorded event at: 
http://www.thebrain.com/site/about/events/landscape7/default.html
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“My People Network” Brain 
Frank used to have a rolodex file (and before that a “little black book”) where he 
kept all his names and address but it got unwieldy. He’s a technically savvy guy 
and knows there are lots of applications available for keeping track of his friends, 
relatives, and acquaintances electronically. Having used PersonalBrain for a 
while he’s come to the conclusion that it would be most efficient to just keep a 
separate Brain for this purpose. Then, not only can he look up information 
quickly, but he can readily see relationships he might have otherwise missed and 
he can easily track who knows who and how he met people. Here’s what Frank’s 
“My Address Book” Brain might look like: 
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Glossary 

Activate To bring a Thought to the center of the Plex and make it 
the active Thought. 

Active Thought The Thought you are working on right now. The active 
Thought occupies the center of the Plex. The active 
Thought’s details are described in the Properties & 
Attachments tab. Only the active Thought can be 
opened by clicking it. A Thought that is not active can be 
activated by clicking it, its pin, or its name in a list and 
pressing Enter. 

Application A program such as a word processor, database, Web 
browser, game, or photo editor. 

Brain button When PersonalBrain window is set to Auto Hide, it 
disappears when you begin working in another 
application and is replaced by the Brain button. Click the 
Brain button to show the PersonalBrain window or attach 
files by dragging them to the Brain button. 

Brain A collection of associated Thoughts each of which can 
have content. PersonalBrain can create multiple Brains. 

Child Thought A Thought with at least one parent. Children of the active 
Thought appear in the child zone, below the active 
Thought. In turn, the active Thought is a child of any 
Thought that appears above it in the parent zone. 

Delete The complete removal of a Thought and/or its content 
from a Brain. Deletion is permanent. 

Drag and drop To use this feature, select the item you want to drag, 
click the mouse button and drag the item to where you 
want it to appear. 

Forget To remove a Thought from PersonalBrain without 
deleting it, its links, its content, or its note. Forgotten 
Thoughts can be “remembered.” 

Forgotten 
Thought 

A Thought that is removed from PersonalBrain without 
deleting it, its links, its content, or its note. Forgotten 
Thoughts can be “remembered.” 
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Gate The active Thought and its close relatives have three 
circular “gates,” each of which is used to link to a specific 
relation: The parent gate is above a Thought; the child 
gate is below it; and the jump gate is beside it. A gate is 
hollow when there are no links through it, and solid when 
links exist. 

Home Thought The Home Thought is the main or top Thought of your 
PersonalBrain. It is the Thought that is activated when 
you click the Home button in the PersonalBrain toolbar.  

Jump Thought A jump Thought is linked to another Thought through its 
jump gate and appears in the jump zone to the left of the 
active Thought. Activating a jump Thought produces a 
more significant reconfiguration of the Plex than 
activating a child Thought or parent Thought. This is 
because jump Thoughts of the active Thought are 
related exclusively to the active Thought and not to other 
Thoughts in the Plex. 

Link The act of connecting Thoughts thereby establishing 
close relations. Also, the line connecting two Thoughts in 
the Plex. 

Link Type A category of links that allows you to distinguish how 
Thoughts are related visually. For example, you could 
have a Link Type called “writes” set so that links 
between authors and books display brown with the label 
“writes.” 

Navigate To move from Thought to Thought by activating 
Thoughts. 

Notes Every Thought can have Notes, displayed in the Notes 
tab of the Tools window. Notes can hold any 
combination of text, images, sound, or shortcuts. The 
Notes function includes a word processor.  

Parent Thought A Thought that has at least one child. A parent Thought 
is linked to its child Thoughts through its child gate. The 
active Thought is a parent of any Thought displayed in 
its child zone, below it. Parent Thoughts of the active 
Thought appear in the parent zone, above the active 
Thought. 

Parentless 
Thought 

A Thought without a parent Thought. A parentless 
Thought is often a jump Thought or a Thought 
representing a subject heading or organizer. Usually, the 
first Thought in a Brain (generally named after the user) 
is a parentless Thought. 
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Past Thought list The scrollable list of Thoughts at the bottom of the Plex, 
arranged in the order activated. The most recently 
activated Thought is the rightmost Thought in the list. 

Pin An entry point to a Brain. Click a pin to activate its 
Thought. A pin is created by dragging a Thought to the 
area immediately below the menu bar. The pin stays 
there until it is removed by being dragged into the menu 
bar or title bar. You can also create a pin of the active 
Thought from the Thought menu. 

Plex The visible portion of your Brain; includes the active 
Thought, its close relations, and the links between them. 
It also includes the Search box, the Past Thought List, 
and navigation tools. 

Remember A Thought that has been removed from the Plex by 
“forgetting” can be remembered by dragging a Link from 
it to any existing Thought in the Plex window that is not 
forgotten. 

Search field The field to the left of the Search button at the bottom of 
the Plex. Type text in this field to perform an Instant 
Activation search. 

Search button The button at the bottom of the Plex that is used to 
perform an extended search for the item typed in the 
Search field. 

Siblings Two or more Thoughts with a common parent. When a 
Thought that has siblings is active, its siblings are 
displayed in the sibling zone, to the right of the active 
Thought. 

Template A file used as the basis for creating other files. Template 
files can be added to the window of the Add 
Attachment dialog box. 

Thought The basic unit of a Brain. A Thought can represent 
anything the user wants it to. A Thought can have 
content in the form of a file, shortcut, or Web page, or it 
can be devoid of content and simply act as a subject 
heading or organizer.  

Thought Type A way to categorize Thoughts and give them distinct 
colors. For example, you can have a “Person” Thought 
type so that all Thoughts that are people display as 
green. 
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Unlink Unlink Thoughts that you no longer want to be related to 
any other Thought in your Brain, or when you want to 
remove a superfluous link. You cannot unlink a 
Thought’s only Link to the active Thought. 

URL Universal Resource Locator; the address of a Web site. 

Virtual Thought A Thought created when a folder is dragged into 
PersonalBrain. Virtual Thoughts are not searchable. 

Wander The option to step randomly through PersonalBrain, to 
let you see Thought associations. 

Zones Areas in the Plex devoted to specific relations of the 
active Thought. There are four zones: the parent zone 
above the active Thought, the child zone below it, the 
jump zone to its left, and the sibling zone to its right. 
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Index 

A 
Activate · 180 
active Thought · 4 
Active Thought · 180 
Address Book · 157 
Advanced Tools Layout command · 118 
anchor Thoughts · 105 
attachments · 20, 56 
Attachments · 73, 74, 83, 86, 87, 88, 89, 90, 

91, 92, 154 
Auto Hide · 180 
Auto Hide button · 180 
auto-hide mode · 16 
B 
backgrounds · 71 
Brain window, auto-hide · 37 
Brain window, float · 37 
BrainZip · 160, 171 
button bar · 13, 17, 25, 32, 120, 181 
C 
Calendar · 145, 146, 147, 148, 149 
case-sensitivity · 113 
Child · 181, 183 
Child Thought · 6, 180 
circle highlight · 15 
Collapse All · 99 
color · 71, 72, 74, 76, 77, 80, 81 
Color, Preferences · 47 
compatibility · 8 
convert older Brains · 8 
copy a Thought to another Brain · 58 
copy a Thought within a Brain · 56 
copy and paste · 86, 87 
copy formatting · 122 
copy outlines into a Brain · 168 
copy Thoughts into another program · 166 
counting words · 126 
create multiple Thoughts · 15 
create Thoughts · 14 
D 
default Brain settings · 36 
delete a Thought · 62, 78 

Details tab · 133, 154 
Dismiss event · 149 
Drag and drop · 84, 86, 87 
dragging 

sticking · 105 
Dragging · 67, 180 
drop shadows · 71 
duplicate of a Thought · 58 
E 
Email Attachment Using Mail command · 

158 
ESP Sync · 111, 112, 113 
Event, snooze · 149 
Excel · 165, 167, 168 
Expand All · 99 
Expanded Thoughts · 100, 102, 150 
export to a Web page · 162, 164 
F 
filename extensions · 7 
filtering · 108 
Forgetting Thoughts · 180 
forgotten Thoughts · 61, 62 
Format Painter button · 122 
G 
gate · 7 
Gates 

filled · 181 
hollow · 181 
Jump · 181 
Parent · 181 
Sibling · 181 

General , Preferences · 44 
guided tour · 10 
H 
Home Thought · 181 
I 
iCal · 157 
icons 

removing · 76 
zoom · 76 

images 
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attaching · 74 
Instant activation · 19, 134 
J 
Jump · 181 
jump Thought · 6 
Jump Thought · 181 
L 
label 

Thoughts · 74 
link · 7 

labels · 79 
Link · 67, 181 

properties · 80 
Link by dragging · 68 
Link by Selecting a Thought in the Create 

Child Dialog Box · 69 
Linking existing Thoughts · 67 
Look & Feel, Preferences · 45 
M 
Mail integration · 157 
merging entire Brains · 167 
mouse wheel · 104, 107 
Move File into Brain command · 87 
multiple platforms · 2 
multiple Thoughts · 64 

de-select · 64 
select · 64 

N 
Notes · 93, 119, 121, 122, 123, 124, 126, 

134, 154 
images · 126 

O 
Operating Systems · 2, 3 
outlines · 166 
Outlook · 90, 152, 153, 154 
P 
Parent · 181 
parent Thought · 5 
Parentless Thoughts · 181 
Past Thought list · 33, 161 
Past Thought List · 33, 68, 182 
PersonalBrain · 1 
PersonalBrain toolbar · 42 
PersonalBrain window · 10 
Pins · 17, 67, 182 

create · 67 

pins, create · 32 
Pins, hiding · 110 
pins, remove · 32 
Plex · 4, 5, 8, 16, 17, 19, 21, 30, 31, 32, 33, 

36, 37, 38, 41, 42, 43, 61, 64, 81, 83, 85, 
87, 88, 93, 98, 103, 104, 105, 107, 109, 
111, 112, 121, 150, 152, 180, 181, 182, 
183 
panning · 104 
scaling · 104 

Plex, move and resize · 38 
Preferences · 131 
Preferences dialog box · 43 
Presentation mode · 110 
previous version of PersonalBrain · 7 
printing · 150 
R 
redo and undo actions · 59 
relationships, change using links · 70 
Remember · 182 
rename Thoughts · 60 
Reports · 142 
Reset Tools Layout · 118 
S 
Save as · 88 
Save Expanded view · 106 
scroll bars · 107 
Search file attachments · 159 
Search, Preferences · 51 
searching · 134 
selection · 64, 65 
semicolon trick · 15, 18, 54 
Sibling · 182 
sibling Thought · 6 
spell checker · 121 
sticking Thoughts · 105 
super type · 79 
Swap Thought name and label · 56 
Switch button · 56 
Switch View button · 97 
T 
tables · 123 
Tags · 128, 132 
Templates · 182 
Themes · 39, 40 
Thoughts · 1, 3, 67, 182 

collapsing · 103 
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distance between · 104 
expanding · 103, 104 
images · 74 
relocacting · 105 
sizing · 72 

Thoughts, creating multiple · 54 
Thoughts, forget · 61 
Thoughts, select multiple · 64 
Thoughts, unlink · 66 
Thoughts, virtual · 93 
Tool tabs · 114 
U 
UI, Preferences · 49 
undo and redo actions · 59 
Unlinking Thoughts · 183 
URL · 183 
Use the Create Child Dialog Box to Link · 69 

V 
view 

expanded · 100 
virtual Thoughts · 93 
W 
Wallpaper · 41, 42 
Web page attachments · 21 
Welcome screen · 11 
Word · 165, 167, 168 
Z 
Zones · 183 

Child · 183 
Jump · 183 
Parent · 183 
Sibling · 183 
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